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1 INTRODUCTION

Ce mode d'emploi décrit la mise en service des switch et la configuration des principales
fonctions de base.

L'utilisateur de ce manuel doit avoir les connaissances suivantes :

Connaissance de l'installation et de la manipulation de dispositifs électroniques

Familiarité avec les systémes informatiques

Connaissance des Local Area Networks (LAN) et connaissances de base en communication IP
Savoir utiliser un navigateur Web

1.1 Contenu
La notice d'utilisation est divisée en chapitres suivants :

. Introduction
. Mise en service des switches
. Options de diagnostic et mise a niveau du firmware

1.2 A propos de nous

Partout ou les réseaux doivent étre transportés rapidement et en toute sécurité pour une
transmission vidéo de la plus haute qualité, barox Kommunikation assure, avec ses switches
POWERHAUS, des connexions révolutionnaires.

barox planifie, coordonne et fournit des connexions point a point simples ainsi que des réseaux
étendus avec des applications multicast.

1.3 Site Internet

Des informations sur I'ensemble de la gamme de produits Switch ainsi que des liens pour
télécharger les fiches techniques, la documentation et le firmware actuel sont a votre disposition
sur notre site Internet www.barox.ch.

1.4 Assistance

Nos partenaires POWERHAUS sont a votre disposition pour d'éventuels probléemes ou questions
concernant la configuration des switches.

2 Description sommaire

Tous les switches RY sont des commutateurs IP Full-Gigabit avec fonctions Layer 2/2+, équipés
de différents nombres de ports optiques et électriques, pouvant étre gérer et supportant jusqu'a
PoE++ selon le modéle.

2.1 Particularités des réseaux vidéo

. Surveillance active de la caméra

Les caméras alimentées par le switch via POE sont surveillées en permanence. En cas de panne
de la caméra, le switch redémarre automatiquement la caméra. En cas d'échec, le switch envoie
un message d'alerte via SNMP.

. Surveillance active de I'alimentation PoE
Si, par exemple, une caméra défectueuse nécessite trop de puissance de la part du switch, ce
dernier émet une alerte via SNMP.

. Gestion active de la puissance PoE
Lorsque le switch démarre, les ports PoE individuels peuvent étre démarrés avec une
temporisation pour éviter une surcharge des blocs d'alimentation PoE.
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. Autres caractéristiques utiles
Les trames Jumbo jusqu'a 9.600 octets sont également prises en charge a 100 Mbit/s.
Sécurité des ports par restriction d'adresse MAC et détection IP.

Lisibilité ou fourniture de certificats.
Performances Backplane trés élevées pour une transmission vidéo fluide lors d'occupation totale
des ports.

Possibilité de voir quels ports regoivent POE en appuyant sur un bouton (panneau avant).

2.2 DMS (Device Management System)

Le switch dispose d'un systeme intégré de surveillance et de contrble du réseau qui donne

a l'utilisateur une vue d'ensemble trés simple de la totalité du réseau.

L'apercu de la topologie du réseau permet une vue d'ensemble rapide de tous les switches et
terminaux disponibles sur le réseau, tels que les caméras IP ou les serveurs, avec des détails
sur l'adresse IP, le type de périphérique et le nom du périphérique. Les plans d'étage et les
plans d'environnement peuvent étre stockés sous forme d'images d'arriére-plan, avec lesquelles
l'utilisateur peut accéder rapidement a certains périphériques réseau méme sans connaitre la
structure IP.

Les plans finis peuvent étre exportés a nouveau et il est possible d'y joindre des documents.

3 Mise en service

Les switches peuvent étre configurés a l'aide d'un navigateur Web. Pour cela, le PC/ordinateur
portable peut étre connecté a n'importe quel port RJ45. Veuillez faire attention a ce que le
PC/ordinateur portable avec l'adresse IP se trouve dans le méme segment de réseau que le
switch. Par exemple : 192.168.1.111

Sinon, les switches peuvent également étre configurés via CLI (port console). Cette
documentation explique comment configurer le switch a l'aide d'un navigateur Web.

3.1 Réglages d'usine et login
Les switches ont les réglages d'usine suivants :

Adresse IP : 192.168.1.1
Masque de sous-réseau : 255.255.255.0
Utilisateur : admin

Mot de passe : admin

En entrant I'adresse IP du switch (192.168.1.1.1) directement dans le navigateur Web,
la connexion au switch s'établit. L'identification s'effectue en saisissant le nom d'utilisateur
et le mot de passe.

€ c o 192.168.1.1 n o =
£* Meistbesucht @ Erste Schiitte

Une fois la connexion réussie, la page "System Information" s'affiche automatiquement
et présente les principales informations concernant le switch.

barox Kommunikation 6



3.2 System Information
Cette page permet de voir les principales informations concernant le switch.

RY-LGSP16-10 P+ =
&« c @ ® 192.168.1.1 o e @ Ty N @

£ Meistbesucht @) Erste Schritte

D $arox

RY-LGSP16-10

H e &

System Information 1 @rome Information
Switch DMS 5

Model Name RY-LGSP16-10
& Configuration 2
System Description 10-Port GbE Web Smart+ Managed PoE Switch
L Monitor v
Location Labor
» System v
Contact Labor
> Information
> IP Status. System Name RY-LGSP16-10
> Log System Date 2011-01-01T04 2 11+01:00
> Detailed L
< System Uptime 03: 3 1
> Overview
S Cieen'Lihemet . Bootloader Version v1.15f
» Ports < Firmware Version v6.54.313274119-04-04
L £ Hardware Version v1.01
» Security <
» LACP 2 Mechanical Version v1.01
> Loop Protection Serial Number C012317AR0300002
2 Spannng ies £ MAC Address 38-b8-eb-20-34-62
» IPMC <
Memory Total=85447 KBytes, Free=72268 KBytes, Max=71984 KBytes
» LLDP <
> POE FLASH 0x40000000-0x41ffffff, 512 x 0x10000 blocks
A ELE CPU Load (100ms, 1, 10s) 0%, 4%, 2%
Légende :
1. Nom du modele du switch
2. Version du firmware
3. Version du matériel
4. Adresse MAC
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3.3 Attribuer une adresse IP fixe ou DHCP

La premiére étape consiste a attribuer une adresse IP au switch. Pour ce faire, sélectionnez
le point de menu "Configuration/System/IP" dans I'arborescence.

RY-LGSP16-10 b+ =

(3 c ‘ ® 192.168.1.1/ip_config.htm| Nvo(B0% e w ‘ o =
> barox= S
RY-LGSP16-10 IP Configuration @Home e
Switch DMS
Mode Host v
& Configuration v
» System ji| |DNS Server Configured || eses
> Information DNS Proxy o
> IP
SN IP Interfaces
> Time
> Log IPv4 DHCP 1Pv4
» Green Ethernet < Delete VLAN Enable Fallback Current Lease Address Mask Length
» Ports Configuration <
1 O 0 152168.1.1
» DHCP. <
» Secutity <
‘Add Interface
» Aggregation <
> Loop Protection Link-Local Address binding interface VLANT |v
» Spanning Tree <
BEME € IP Routes
» LLDP <
» PoE < Delete Network Mask Length Gateway Next Hop VLAN
> MAC Table O 0.0.0.0 0 192.168.1.254 0
> VLANs
169.254.0.0 16 192.168.1.1 0
» Private VLANs <
»VCL o 192.168.1.0 24 192.168.1.1 0
» Voice VLAN <
» QoS o ekl
> Mirroring

Adresse IP fixe

L'image ci-dessus montre que le switch posséde l'adresse IP 192.168.1.1, le masque de sous-
réseau 24 (255.255.255.0) et appartient au VLAN 1. Le VLAN 1 est donc le VLAN de gestion.

Si une nouvelle adresse IP doit étre attribuée au switch, I'adresse IP existante doit étre écrasée
et confirmée par I'icbne "Apply". Il en va de méme si le masque de sous-réseau doit étre modifie.

DHCP

Si le switch est intégré dans un réseau dans lequel un serveur DHCP attribue les adresses IP,
le champ doit étre marqué sous "IPv4 DHCP".

Le serveur DHCP attribue au switch une adresse IP dans la plage prédéfinie.
Il'y a deux fagons de trouver I'adresse IP recue.

a) Outil logiciel, par exemple : SoftPerfect Network Scanner
https://www.heise.de/download/product/network-scanner-13270

b) Port console

On utilise a cet effet le cable de console fourni. Le port console du switch est une interface
RS232. Il faut alors un PC/ordinateur portable équipé d'une interface de série ou un
convertisseur USB-RS232.

En ce qui concerne le logiciel, nous recommandons "PuTTY" pour configurer le switch via
le port CLI.

http://www.chip.de/downloads/PuTTY 12997392.html
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L'interface CLI est réglée en usine comme suit :

Débit binaire : 115.200
Bits de données : 8

Parité : aucune
Bits d'arrét : 1
Contréle de flux : aucun

Une fois la connexion a l'interface de série établie, un login a l'aide d'un nom d'utilisateur et
d'un mot de passe est nécessaire.

L'adresse IP peut étre interrogée avec la commande suivante :
RY-LGSP23-26%# show ip interface brief

> Important : la modification doit maintenant étre sauvegardée définitivement.

Pour ce faire, accédez au switch via un navigateur Web avec la nouvelle adresse IP
et cliquez sur le symbole de la disquette dans le coin supérieur droit.

3.4 Configuration de la passerelle

Si une nouvelle adresse IP a été attribuée au switch, I'adresse de passerelle doit étre adaptée
en conséquence.

IP Routes
Delete Network Mask Length Gateway Next Hop VLAN
O 0.0.0.0 0 192.168.1.254 0

169.254.0.0 16 192.168.1.1 0

192.168.1.0 24 192.168.1.1 0

Pour modifier I'adresse de la passerelle, la ligne doit d'abord étre supprimée, puis recréée avec
I'adresse correcte. L'adresse réseau doit étre réglée sur "0.0.0.0" et la longueur du masque sur
"

Seule l'adresse de la passerelle doit étre réécrite en fonction du réseau.
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3.5 Réglage de I'heure

L'heure systéme des switches barox peut étre configurée manuellement ou via un serveur NTP.
La définition de I'heure sert au fichier journal. En cas de message d'erreur, I'entrée dans le
fichier journal est complétée par un horodatage afin de consigner avec précision les
dysfonctionnements et les temps d'erreur et de localiser les causes possibles.

3.5.1. Réglage locale

Dans le menu "Configuration/System/Time", sélectionner "Use Local Settings" comme "Clock
Source". Dans le champ en dessous de "System Date", entrer ensuite la date et I'heure
manuellement selon le format voulu et confirmer avec la touche "Apply".

> Si le switch est redémarré, I'heure est perdue et doit étre reconfigurée car le switch
n'a pas de batterie de secours.
RY-LGSP16-10 b + =
&« C ® 192.168.1.1/da w N @ =
£ Meistbesucht @) Erste Schritte
> barox-= &

RY-LGSP16-10 Time Configuration

@tome Time

Switch DMS
Time Configuration
# Configuration v
» System .  Clock Source Use Local Settings  [v
> Infc i
Biotmaton System Date 2011-01-0104:44:5  ( yyyy-mm-dd hh:mm:ss )
> 1P
> NTP E ) N
Time Zone Configuration
> Time
> Log Time Zone (GMT+01:00) Amsterdam, Berlin, Bern, Rome, Stockholm, Vienna |~
» Green Ethernet %
» Ports Configuration < Acronym (0 - 16 characters )
» DHCP <

barox Kommunikation 10



3.5.2. NTP (Network Time Protocol)

Le Network Time Protocol est un standard pour la synchronisation des horloges dans les
systémes informatiques via des réseaux de communication par paquets.

La configuration s'effectue en deux étapes.

3.5.2.1. Serveur NTP
La premiére étape consiste a dire au switch ou il doit obtenir I'heure.

Si I'heure doit étre obtenue directement du serveur DHCP, placez le champ "Automatic" sur
"Enabled". L'adresse IP du serveur DHCP est alors affichée dans la ligne en dessous.

Si I'heure doit étre obtenue a partir d'une source spécifique, par exemple un serveur de temps,
un serveur NTP ou un pare-feu etc., I'adresse IP correspondante doit étre saisie dans le champ
"Server address 1". C'est la seule facon de s'assurer que le switch peut atteindre I'adresse IP.
Il est possible de définir jusqu'a 5 sources.

Si aucune source de temps n'est disponible dans votre propre réseau et qu'une source doit étre
obtenue de I'extérieur via Internet, un serveur NTP externe peut également étre saisi directement,
par exemple 213.209.109.45 de https://www.ntppool.org/fr/

RY-LGSP16-10 x i — X
&« C ® 192.168.1.1/ntp.ht % g N @ =
£ Meistbesucht @) Erste Schritte

~
> barox= nee

RY-LGSP16-10 NTP Configuration @Home e

Switch DMS

Automatic Enabled |v
# Configuration v
> Sysiom _  Serveraddress via DHCP

> Information

5P NTP Time-Sync Interval 50 q

il Server address 1 213.200.109.45

> Time

> Log Server address 2

» Green Ethernet
Server address 3
» Ports Configuration

S s oG

» DHCP Server address 4
» Security

) Server address 5
» Aggregation

> Loop Protection

» Spanning Tree < AL

3.5.2.2.Réglage de I’heure

Dans le menu "Configuration/System/Time", sélectionner "Use NTP Server" comme "Clock
Source".

RY-LGSP16-10 b + = X
& c ® 192.168.1.1/daylight_saving_config.htm w N @ =
%+ Meistbesucht @ Erste Schritte
> barox= ks

RY-LGSP16-10 Time Configuration @ome Time

Switch DMS

Time Configuration
& Configuration v
i Use s

e System Date IR Y- hivmm:ss )

> 1P

> NTP ) ) .

Time Zone Configuration
> Time
> Log Time Zone None i
» Green Ethernet <
» Ports Configuration | Acronym (0=10:characters;)
» DHCP <
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Comme les serveurs d'heure donnent généralement I'heure moyenne de Greenwich,
la "Time Zone" doit étre sélectionnée en conséquence pour que a) I'heure soit correcte
et b) I'neure d'été/d'hiver soit réglée correctement.

RY-LGSP16-10 b + = X
<« cC @ ® 192.168.1.1/daylight_saving_config.htr IO +4 INn @ =

£ Meistbesucht @ Erste Schritte

> barox=

RY-LGSP16-10

Time Configuration @Home Time

Switch DMS
Time Configuration

£ Configuration v
» System o Clock Source Use NTP Server P
> Informati
el System Date 2019-05-06 14564 ( yyyy-mm-dd hh:mm:ss )
> 1P
> NTP ) " .
Time Zone Configuration
> Time
> Log Time Zone (GMT+01:00) Amsterdam, Berlin, Bern, Rome, Stockholm, Vienna  |v-
» Green Ethemet <
» Ports Configuration < Acronym (0 -16 characters )
» DHCP <

Dés que le switch peut obtenir I'heure et la date, I'heure correcte est affichée dans le champ
"System Date".

3.6 Configuration des ports

Les ports sont réglés en usine en mode Auto. L'autonégociation est une procédure qui permet

a deux ports réseau Ethernet interconnectés de négocier et de configurer automatiqguement la
vitesse de transmission maximale possible et la procédure duplex. Cette procédure ne s'applique
gu'aux cables a paires torsadées et non aux connexions par fibre optique.

Néanmoins, il peut arriver que le terminal final ne soit pas reconnu correctement. Cela se produit
de temps en temps avec les caméras ayant une interface 100 Mbit/s. Dans ces cas, le port doit
étre réglé manuellement sur 100 Mbit/s.

Si un port n'est pas utilisable pour des raisons de sécurité, il peut également étre complétement
désactivé. Pour cela, le mode de configuration doit étre réglé sur "Disabled".

RY-LGSP16-10 b+ =
- Cc @ ® 192.168.1.1/ports.htm ww m e =
¥ Meistbesucht @) Erste Schritte
~
> barox-= e
RY-LGSP16-10 Ports Configuration Bitiomee s
Switch DMS B
# Configuration v
S veom . Speed Flow Control
» Green Ethernet < Port Link Current Configured Current Rx Current Tx Configured Maximum Frame Size
» Ports Configuration v o
v 96!
> Ports O
> Ports Description 1 1Gfdx — & @ ® D —
» DHCP <
» Security . - @ Down F Alifo | @ Q O 9600
» Aggregation < Disabled
> Loop Protection 3 Down e 6
> ‘ 10Mbps HDX ® @ D 9600
» Spanning Tree < 10Mbps FDX
» IPMC . 4 @ Down 1000bps HOX (7)) (7)) 9600
O
» LLDP < 1Gbps FOX
» PoE < 5 [ ] Down Auto ‘@ (7)) O 9600
> MAC Table

barox Kommunikation 12



3.6.1. Port SFP

Les ports SFP disposent également d'un mode automatique. Celui-ci différe de I'auto-négociation
des ports en cuivre. Avec l'auto-négociation, les ports SFP ne peuvent détecter que la vitesse de
transmission et ne prennent en charge que le full-duplex.

Il peut arriver que le switch ne reconnaisse pas correctement un SFP, qu'il s'agisse d'un SFP de
100 Mbit/s ou de 1000 Mbit/s et qu'il ne fonctionne donc pas. Dans ce cas, le débit de données
sur le port doit étre configuré manuellement.

9 ®© Down Auto ‘| @ 7)) — =

10 ® Down ‘ Filb j Q ) = .
Disabled

Apply 100Mbps FDX

1Gbps FDX

Les ports SFP des switches ne sont pas codés. Cela signifie que les SFP d'autres fabricants
peuvent également étre utilisés, toutefois sans garantie de fonctionnement.

La gamme barox comprend des SFP pour fibres multimodes et monomodes avec des vitesses
de transmission de 100 Mbit/s, 1 Gbit/s ou 10 Gbit/s. Les distances possibles varient en fonction
du type de fibre et de la vitesse de transmission entre 550 m et 120 km.

> Voir http://www.barox.ch/cm/produkte/product/ip-produkte/zubehoer/ac-sfp

3.7 Changer le nom d'utilisateur et le mot de passe

Les switches barox offrent la possibilité de générer plusieurs utilisateurs avec des droits
différents. Il est possible de définir jusqu'a 15 niveaux différents.

Le niveau 15 est le niveau le plus élevé et est destiné aux administrateurs.

RY-LGSP16-10 x g = X
<« Cc @ ® 192.168.1.1/users htr 2R n@o =
£¥ Meistbesucht @ Erste Schritte
> barox-= e

RY-LGSP16-10 Users Configuration BHome i

Switch DMS

User Name Privilege Level
& Configuration v
admin 15
» System
» Green Ethernet T T

» Ports Configuration
» DHCP

» Security

€z © os oA

» Switch
> Users
> Privilege Levels

> Auth Method

Un autre utilisateur peut étre généré avec la fonction "Add New User". Vous devez définir le nom
de l'utilisateur, le mot de passe et le niveau de droits.
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RY-LGSP16-10 x g E

& c @ ® & 192.168.1.1/user_confightrr - 9w N o =

£¥ Meistbesucht @ Erste Schritte
> barox= e
RCUC RO s ons
Switch DMS
User Settings
& Configuration v
» System . UserName Gordi Steiner
» Green Ethemnet 3 Password
» Ports Configuration <
» DHCP < Password (again) sessse
» Security )

Privilege Level {

oL

» Switch v

S oo |
Ca

> Privilege Levels

Le point de menu "Privilege Levels" permet ensuite de définir la diversité exacte des droits du
nouvel utilisateur.

Dans I'exemple suivant, le technicien posséde le niveau de droits 10. Cela signifie qu'il peut tout
configurer grace a des droits de lecture et d'écriture. Pour le "Debug" il a cependant un niveau
de droits trop bas, de sorte qu'il ne peut méme pas lire "Debug".

RY-LGSP16-10 b+ = X
€ c @ ® 192.168.1.1/priv_iviht RN +4 N @ =

£ Meistbesucht @) Erste Schritte

> barox-= .
RY:-LGSP16-10 Privilege Levels Configuration Btome S it
Switch DMS
Privilege Levels
& Configuration v
Group Name Configuration Read-only  Configuration/Execute Read/write Status/Statistics Read-only ~ Status/Statistics Read/write
» System <
» Green Ethemet < ACTIVATE 5 |v 10 |v 5 & 10 o
» Ports Configuration .
L 5 Aggregation 5 |v 10 |v 5 |w 10 |v
» DHCP <
» Security v cloud_management 5 v 10 |v 5 |~ 10 |v
» Switch v
Debug 15 |v 15 |v 15 v 15 |v
> Users
> Privilege Levels DHCP > 10 |v 5 |v 0 |+
> Auth Method
Dhcp_Client 5 |v ) | 5 |v <
> HTTPS s & L 9

Le tableau est trés étendu et les droits peuvent étre affectés de maniére tres détaillée. Par
exemple, vous pouvez définir un utilisateur qui n'est autorisé a lire que la table des adresses
MAC.

3.8 Loop Protection

Dans le cas de vastes réseaux, il peut arriver rapidement qu'une boucle soit physiquement
branchée accidentellement ou involontairement. En I'absence d'un protocole anti-boucles actif
(par ex. RSTP), I'ensemble du réseau s'arréte et devient inopérant.

La fonction "Loop Protection" sert a éviter ce genre de situation. Si cette option est activée, vous
pouvez définir, pour la boucle créée par inadvertance, si le port doit étre désactivé ou si seule
une entrée doit étre effectuée dans le fichier journal, ou bien les deux ("Shutdown and Log").

> Les ports qui sont déja actifs avec RSTP ne doivent pas étre surveillés en plus avec
Loop Protection. Cela entraine des perturbations massives dans le réseau.

Le "Shutdown Time" indique combien de temps un port doit rester désactivé si une boucle est
détectée. Saisie des temps possible : 0 — 604.800 s (7 jours). Si "0" est entré, le port reste
désactivé jusqu'a ce que le switch soit redémarré.
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RY-LGSP16-10 P + = a

&« C ® ® 192.168.1.1/loop_config.htm - O In @ =

£ Meistbesucht @ Erste Schritte
> barox= Sk
RY-LGSP16-10 Loop Protection Configuration o LEog Provecgian
Switch DMS
Global Configuration
& Configuration v
» System ” Enable Loop Protection Enable |v
PG € Transmission Time 5 seconds
» Ports Configuration <
» DHCP ¢ Shutdown Time 180 seconds
» Security X
» Aggregation < Port Configuration
> Loop Protection
. Port Enable Action Tx Mode
» Spanning Tree <
» IPMC < > 5
» LLDP <
1 V| wn Port le |V
» PoE : V| _ Shutdown Po Enable
Shutdown Port
> MAC Table 2 Shutdown Port and Log Enable |v
> VLANs Log Only
» Private VLANs < 3 Shutdown Port v Enable |~
ZVEL N 4 Shutdown Port v Enable |v
» Voice VLAN <

3.9 Configuration en anneau

Afin d'assurer la redondance dans le réseau, il est absolument nécessaire de mettre en place
une topologie en anneau. Pour éviter que le réseau ne soit surchargé par un broadcast storm
(tempéte de diffusion), un mécanisme de protection est nécessaire.

RSTP (Rapid Spanning Tree Protocol) est I'un des protocoles de base des réseaux Ethernet. Il
garantit qu'aucune boucle de réseau ne se produit dans un segment de réseau. Contrairement
aux paquets IP, les trames Ethernet n'ont pas de durée de vie maximale (Time to Live, TTL) et
peuvent donc tourner en rond pendant une durée infinie, ce qui peut surcharger le réseau et,
dans le pire des cas, l'immobiliser.

Wikipedia explique en détail la fonction du Rapid Spanning Tree Protocol (RSTP)
https://fr.wikipedia.org/wiki/Spanning_Tree Protocol

3.9.1. Ring Master

Dans une topologie en anneau, un switch doit étre défini comme le Master responsable de la
surveillance de I'anneau. En cas d'interruption éventuelle de la connexion, il le signale a tous les
switches de l'anneau afin que la connexion alternative soit activée. Le switch avec la priorité 0
est le Ring Master.

Le protocole RSTP est concgu de telle sorte que, sans Ring Master défini, le switch ayant la plus
petite adresse MAC devient automatiguement le Ring Master.

RY-LGSP16-10 P+ s =]
[rricsrieio] g D 192.168.1.1 f e nmol =
£* Meistbesucht @) Erste Schritte
> barox= hee
RY-LGSP16-10 STP Bridge Configuration @rome Bridge Settings
Switch DMS
Basic Settings
& Configuration v
» Systom . | Protocol Version RSTP |v
» Green Ethernet < ; — : St
R, Criaoe Friorty il Ring Master hat Priority "0"
» DHCP < Forward Delay
ooy s Max Age 2
» Aggregation <
> Loop Protection Maximum Hop Count

» Spanning Tree v

> Bridge Settings

Transmit Hold Count
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La version du protocole souhaitée doit étre sélectionnée dans le menu "Spanning Tree / Bridge
Settings". RSTP est supporté par tous les fabricants de switches et est donc compatible avec les
fabricants tiers.

Par défaut, les switches ont la "Bridge Priority" 32768. Si le switch doit agir en tant que Master,
la Bridge Priority doit étre réglée sur "0". Toutes les autres valeurs peuvent étre laissées telles
guelles.

3.9.2. Configuration des ports

"STP Enabled" est actif pour tous les ports a la sortie de l'usine. Ainsi, I'anneau peut
théoriguement étre formée a n'importe quel port. Pour une répartition optimale de la charge
dans le réseau, le flux de paquets de données peut étre contrdlé par définition a l'aide des
codts de traversée. Le terme "colts de traversée" vient de I'époque ou les lignes étaient louées
pour la connexion de A a B et étaient donc chéres.

> barox-= S
RYALGSPI16:10" 1 57p ¢IST Port Configuration @rome
Switch DMS
CIST Aggregated Port Configuration
& Configuration v
» System < Restricted
» Green Ethernet < Port STP Enabled Path Cost Priority Admin Edge Auto Edge Role TCN BPDU Guard Point-to-point
» Ports Configuration &
Ao |v 128 |v Non-Edge |v O O O Forced True  |v
» DHCP <
» Security <
A= tion . CIST Normal Port Configuration
> Loop Protection Restricted
» Spanning Tree v
. - Port STP Enabled Path Cost Priority Admin Edge Auto Edge Role TCN BPDU Guard Point-to-point
> Bridge Settings
> MSTI Mapping % < v o v < v O O d < v
> MSTI Priorities
TR 1 Ao |v 128 |v Non-Edge |v O O O Auto v
> MSTI Ports 2 Auto  |v 128 |v Non-Edge |v O o 0O Auto v
» IPMC <
3 ™~ v 128 |v g v ™~ v
S . v Auto 2 Non-Edge v O O O Auto
Exemple :

Dans le cas d'un anneau plus grande avec plusieurs terminaux et une plus grande quantité de
données, il est judicieux de diriger le flux de données dans I'anneau de maniére & ce que les
switches soient chargés uniformément (répartition de la charge). Il faut pour cela définir les colts
de traversée.

Prio 4096

Prio 32768

Port9

e Datenfluss Pfadkosten
20’000

Prio 32768 /\ Prig 32768 :
® B D E F o B3
g Port9 ’ Port 10 Port9 ’ Port 10 Port9 ‘ Port 10 i

x l 5x l 3x l

Datenfluss

Prio 32768

barox Kommunikation 16



Dans I'exemple illustré, le réseau se compose de deux switches centraux (A+B) et de 5 autres
switches qui forment ensemble un anneau. Au total, 21 caméras sont installées, chacune
fournissant 5 Mbit/s de données vidéo. Ce sont donc au total plus de 100 Mbit/s de données.

Scénario 1 : seul RSTP est actif sur tous les switches

Le switch avec 'adresse MAC la plus basse endosse la fonction de Master Il se peut que ce soit
le plus petit switch avec la puissance de processeur la plus faible de I'anneau. La direction du
flux de données est inconnue.

En cas d'interruption, le temps de commutation peut étre un peu plus long, car le petit switch ne
peut pas traiter les données aussi rapidement.

Scénario 2 : RSTP actif sur tous les interrupteurs, switch-A Prio 0 et switch-B Prio 4096

Dans ce cas, Switch A endosse la fonction Master par définition. S'il subit une défaillance, le
switch B hérite de la fonction Master. Switch A surveille I'anneau, et, en cas d'interruption du
réseau, le processeur a suffisamment de puissance pour agir rapidement. Sur switch A, le port
21 peut étre marqué comme "Blocked". Cela signifie que le flux de données de toutes les
caméras vidéo passe par le port 22. Le petit Switch C doit traiter les données de toutes les
caméras vidéo, ce qui crée goulot d'étranglement.

Scénario 3 : RTSP actif, Master défini et colts de traversée définis

Cette configuration définit exactement le flux de données. La charge est répartie sur deux cotés.
Aucun switch n'atteint ses limites. Etant donné que les colts de traversée au niveau du Switch
D, port 10 et du Switch E, port 9 sont plus élevés qu'a tous les autres ports de I'anneau, ce trajet
n'est activé qu'en cas d'interruption dans le réseau.

Réglage d'usine des colts de traversée :

Les colits dépendent de la distance au Root Bridge (Master) et de la liaison montante disponible
vers la destination. Une liaison montante a 100 Mbit/s a généralement des co(ts de traversée
plus élevés qu'une liaison montante a 1 Gbit/s vers la méme destination, de sorte que la liaison a
100 Mbit/s serait bloquée car considérée comme un trajet redondant. Les codts de traversée
sont normalisés selon les spécifications IEEE, mais peuvent étre réglés differemment
manuellement, par exemple pour sélectionner une liaison montante préférée en cas de vitesse
égale afin de refléter le colt réel des lignes dédiées.

> Dans la mesure du possible, la configuration doit étre orientée telle qu'illustrée sur
I'image.
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3.10 Configuration VLAN
La configuration du VLAN se fait seulement d'un coté.
Dans le champ "Allowed Access VLANs", tous les numéros de VLAN a configurer doivent

étre indiqués.

> barox=

RY-LGSP16-10
Switch DMS
& Configuration v
» System
» Green Ethemet
» Ports Configuration
» DHCP
» Security
» Aggregation
> Loop Protection

A ANAN AN

» Spanning Tree
» IPMC

» LLDP

» PoE

> MAC Table

> VLANs

» Private VLANs <
»VCL <
» Voice VI AN <

A AT

VLAN Configuration

Global VLAN Configuration
Allowed Access VLANS 1.10.20

Ethertype for Custom S-ports

Port VLAN Configuration

Port Mode Port VLAN Port Type Ingress Filtering Ingress Acceptance
1 < v

1 Acce v 1 ,

2 Acce: v

3 = 3 .

4 Hybrid 1 -l O

5 coess 1 ort

(e.g. 1,2,10-13,15)

Tagged

Tagged

Tagged

Tagged

Tagged

and Untagged

and Untagged

and Untagged

and Untagged |~

and Untagged

Egress Tagging

Untag Port VLAN

jntag Port VLAN

Untag Port VLAN

2 I

@Home VLANS

Allowed VLANs  Forbidden VLANs

Si les numéros VLAN sont listés, les différents ports peuvent maintenant étre affectés
a une fonction et a un VLAN.

Mode VLAN Fonction

Access Nr un terminal est connecté a ce port.

Trunk --- raccordement entre deux switches

Hybrid --- raccordement entre deux switches ou un terminal

Le mode Trunk ainsi que le mode Hybrid permettent de définir quels VLANs sont autorisés
dans la colonne "Allowed VLANS"

3.11 Power over Ethernet (PoE)

Dans la zone PoE, le switch dispose de nombreuses options pour optimiser l'utilisation de PoE.
L'alimentation peut étre mise sous ou hors tension sous contréle de temps ou d'événements.
Les Powered Devices (par ex. les caméras PoE) peuvent également étre surveillés et
redémarrés si nécessaire, et la puce PoE de la caméra peut étre réinitialisée. Ceci est utile

si la caméra est "pingable" mais ne montre pas d'image.
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3.11.1. Configuration PoE

> barox= Hee
RY-LGSP16-10 Power Over Ethernet Configuration BHome onfigurstion
Switch DMS
Reserved Power determined by Class & Allacation LLDP-Med
£ Configuration v
Power Management Mode & Actual Consumption Reserved Power
» System
» Green Ethernet
Capacitor Detection O

» Ports Configuration

» DHCP
PoE Power Supply Configuration

a A A A R A

» Security
» Aggregation PoE Firmware Version 012-001
> Loop Protection

Primary Power Supply [W] 130

» Spanning Tree

» IPMC
PoE Port Configuration

Ses m ey

» LLDP
Bt Port FoE Mode POE Schedule Priority Maximum Power [W]
> Configuration
> Power Delay i 3 » % i 2
> Schedule Profile 1 Enabied. B Profile1  [w Low v 30
> Auto Checking
> Chip Reset Schedule 2 Enabled |~ Profile 2 v High L a0
> MAC Table 3 .
Enabled [v Profile 1 v rtical | 30
> VLANs

Chaque switch a une capacité de performance définie. Celle-ci décrit la quantité d'énergie qui
peut étre fournie via les ports PoE. Elle dépend fortement de l'alimentation électrique intégrée
dans le switch. Dans notre exemple, un switch RY-LGSP16-10 avec 8 ports PoE+ offre max.
130 W. Cela signifie qu'il est impossible de connecter un terminal de 30 W a chacun des 8 ports,
car 240 W seraient nécessaires. L'alimentation électrique intégrée ne peut pas fournir autant
d'énergie.

Par conséquent, il faut prendre en compte l'allocation de puissance par port.

Les consommateurs de PoE sont divisés en différentes classes en fonction de leur consommation.

Classe | L’alimentation électrique disponible pour le Powered Device | Signature de Classification
0 0,44 -1296 W 0a4mA
1 0,44 -3,84W 9al12mA
2 3,84-6,49W 17 420 mA
3 6,49 —1295W 26 a 30 mA
4 12,95 — 25,50 W (802.3at/Type 2 seulement)! 36 444 mA

https://fr.wikipedia.org/wiki/Alimentation % C3%A9lectrique_par_c%C3%A2ble Ethernet

Reserved Power determined by

Sous Reserved Power determined, il est possible de définir comment 'alimentation max.
doit étre déterminée.

- Class = correspond a la classe a laquelle le terminal est identifié

- Allocation selon les spécifications de la colonne "Maximum Power (W)"
- LLDP-Med idem mode Class, obtient I'information via LLDP (si possible)
Si le terminal dépasse la puissance prédéfinie, le port éteint le PoE.

Power Management Mode

Cette section permet de définir le comportement du switch en cas de dépassement
de la puissance maximale possible.

- Actual Consumption
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Si la puissance consommée par tous les appareils dépasse la puissance maximale que le switch
peut fournir, le PoE est completement éteint. Si un seul port dépasse la puissance, le PoE n'est
désactivé que sur le port correspondant.

La colonne "Priority" définit quel port est important. Les ports portant la mention "low" seront

immédiatement désactivés, tandis que les ports marqués "Critical" seront désactivés en dernier
si la puissance totale est dépassée.

- Reserved

Les ports portant la mention "reserved" ne sont désactivés que si la puissance réservée
dans la colonne "Maximum Power (W)" est dépassée.

PoE Schedule
Chaque port peut étre affecté a un horaire. Il est possible de créer un total de 16 horaires.

3.11.2. PoE Power Delay
Comme déja mentionné, le switch peut fournir une puissance limitée.

Les caméras IP d'aujourd'hui ont besoin de plus en plus de puissance. Si on utilise une caméra
panoramique inclinable avec chauffage intégré et spot infrarouge, la puissance requise
augmente encore plus.

En particulier lors du redémarrage, du passage du jour a la nuit, de l'allumage de radiateurs ou
de spots IR etc., les caméras ont besoin de beaucoup plus de courant (= pointes de puissance)
gu'en fonctionnement continu.

Si plusieurs caméras sont maintenant connectées a un switch et que toutes les caméras se
connectent en méme temps, il est possible que la puissance de commutation maximale possible
soit dépassée. En cas de dépassement de la puissance, le switch se déconnecte immédiatement
et I'alimentation électrique subit des dommages si les pannes sont fréquentes.

Pour éviter ce probléme, vous pouvez configurer un démarrage différé de chaque port dans le
menu suivant. Dans |I'exemple suivant, les ports 1 et 2 sont activés immédiatement, puis 2 ports
de plus toutes les 10 secondes.

> bharox= °c
RY-LGSP16-10 PoE Power Delay Btlone E
Switch DMS
Port Delay Mode Delay Time(0~300 sec)
& Configuration v
» System < E 0
» Green Ethernet < 1 Disabled v 0
» Ports Configuration <
» DHCP v 2 Enabled |~ 10
» Security < 3 Eniabled |8 20
» Aggregation <
> Loop Protection 4 Disabled 3¢ 0
» Spanning Tree < 5 F— o
» IPMC <
» LLDP | © Disabled |v 0
yio N 7 Disabled [v 0
> Configuration
> Power Delay 8 Disabled |v 0

> Schedule Profile

> Auto Checking

3.11.3. PoE Schedule

L'allumage et I'extinction du courant peuvent également étre commandés selon un plan horaire
hebdomadaire. Il est possible de créer jusqu'a 16 profils différents. Chaque port peut étre affecté
a un profil.

Dans I'exemple suivant, dans le profil 1, PoE est activé tous les jours de 06h00 a 18h00.
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> barox= nee
RY-LGSP16-10 PoE Schedule Profile @rome Schedule Profle
Switch DMS
Profile 1 @
& Configuration v
» System ” Name Profile 1
» Green Ethernet <
» Ports Configuration < Start Time End Time
2DHCE €| Week Day HH MM HH MM
» Security < *‘
» Aggregation < 5 pidll i fisl = B
> Loop Protection Monday 5 0 o 18 v 0 @
» Spanning Tree <
» IPMC s Tuesday 6 |v 0 |v 18 |v 0 |v
Al < Wednesday s B o [ 18 [ o [
» PoE v
> Configuration Thursday 6 |v 0 |v 18 |v 0 v
> Power Delay Friday
6 |v 0 |v 18 v 0 v
> Schedule Profile
> Auto Checking Saturday 6 |v 0 v 18 |v 0 v

3.11.4. PoE Auto Checking

PoE Auto Checking sert a la surveillance des fonctions. En utilisant ping, par exemple,
I'accessibilité de la caméra connectée au port 1 avec I'adresse IP 192.168.1.25 est vérifiée
toutes les 30 secondes.

Aprés 3 tentatives erronées, PoE est désactivé sur le port 1 et réactivé apres 15 secondes.
Ceci force le redémarrage de la caméra.

60 secondes aprés le redémarrage, la surveillance redémarre via ping.

> barox= Mmec
RYLGSPIG0 | poe Auto Checking avne —
Switch DMS
Ping Check Enabled -
£ Configuration v
» System < Port Ping IP Address Startup Time Interval Time(sec) Retry Time  Failure Log Failure Action Reboot Time(sec)
» Green Ethernet <
= 1 192.168.1.41 60 30 3 error=0, total=0 Reboot Remote PD  [v 15
» Ports Configuration <
ZDHCh o 2 192.168.1.42 60 30 3 error=0, total=0 Reboot Remote PD v
» Security 2
» Aggregation . 3 02.168.1.43 60 30 3 error=0, total=0 Reboot Remote PD |
flacnbieecion 4 0000 60 30 3 error=0, total=0 Nothing 5

3.11.5. PoE Chip Reset Schedule

Il arrive que les caméras soient toujours accessibles par ping, mais n'affichent pas d'image.
Dans la plupart des appareils, la commande PoE est sur une puce séparée. Il est possible que
le processeur réponde a un ping, mais le flux vidéo n'est pas transmis.

Prophylactiqguement, la commande PoE Chip Reset peut étre envoyée quotidiennement ou une
fois par semaine, par exemple a 03h00.

Cette commande redémarre la puce PoE de la caméra.

~

H e .

> barox=

RY-LGSP16-10 PoE Chip Reset Schedule Bome: e e
Switch DMS

Mode Enabled |~
& Configuration v

» System
. PoE Chip Reset Time

» Green Ethernet
» Ports Configuration Week Day HH MM
» DHCP

» Security

@
<
<

A & A A oA oa
<
[ﬂ

» Aggregation Maniaay

> Loop Protection Tuesday

» Spanning Tree <
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3.12 Sauvegarde et chargement de la configuration

Chaque modification doit étre sauvegardée. En sélectionnant "Apply", la modification est écrite
dans la mémoire de travail. Un redémarrage efface la mémoire et tous les changements sont
perdus. Les modifications doivent donc absolument étre sauvegardées.

Il y a deux possibilités :
- Le symbole disquette dans chaque masque
- Dans le menu Maintenance/Configuration/Save startup-config

> barox-= ks
RY-LGSP16-10 Save Running Configuration to startup-config @Home
Switch DMS .
# Configuration < Please note:
The generation of the configuration file may be time consuming, depending on the amount of non-default configuration.
O Monitor <
«ha Diagnostics < En
/& Maintenance v

> Restart Device
> Reboot Schedule
> Factory Defaults
» Firmware <
» Configuration v
> Save startup-config
> Download

3.12.1. Téléchargement de la configuration

La configuration actuelle du switch peut étre téléchargée et sauvegardée séparément. Le fichier
de configuration généré peut étre importé dans le cas du remplacement d'un switch ou utilisé si
plusieurs switches doivent étre configurés de maniére identique et que seule I'adresse IP doit
étre modifiée. Cela permet de gagner beaucoup de temps.

Nous vous recommandons de n'enregistrer que le fichier "startup-config File".

2 barox=

RY-LGSP16-10

2 B

Download Configuration

@Home Download

Switch DMS
Select configuration file to save.
% Configuration € Please note: running-config may take a while to prepare for download.
0 Monitor < File Name
«&a Diagnostics S running-config
/& Maintenance v default-config
> Restart Device & startup-config

> Reboot Schedule

» Facoy Dotats

» Firmware <
» Configuration v
> Save startup-config
> Download

> Upload

3.12.2. Importer la configuration (upload)

La variante inverse consiste a importer un fichier de configuration dans le switch. Pour cela,

il suffit d'indiquer le chemin du fichier enregistré et le type de fichier concerné. Il s'agit
généralement du fichier "startup-config File".
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> barox=

RY-LGSP16-10

Upload Configuration @tome Uplosd
Switch DMS
File to Upload Keine Datei ausgewahit.
£ Configuration <
5 Monitor < Destination File
«h Diagnostics < File Name Parameters
& Maintenance v running-config & Replace Merge
> Restart Device & startup-config

> Reboot Schedule Greatenewiie

> Factory Defaults

» Firmware <
Upload Configuration

» Configuration v
> Save startup-config
> Download

> Upload

4 DMS Device Management System

Le switch dispose d'un systeme intégré de surveillance et de contréle du réseau qui donne a
l'utilisateur une vue d'ensemble trés simple de la totalité du réseau.

L'apercu de la topologie du réseau permet une vue d'ensemble rapide de tous les switchs et
terminaux disponibles sur le réseau, tels que les caméras IP ou les serveurs, avec des détails
sur l'adresse IP, le type de périphérique et le nom du périphérique. Les plans d'étage et les
plans d'environnement peuvent étre stockés sous forme d'images d'arriere-plan, avec lesquelles
l'utilisateur peut accéder rapidement a certains périphériques réseau méme sans connaitre
l'infrastructure IP.

Les plans finis peuvent étre exportés a nouveau et il est possible d'y joindre des documents.

4.1 Gestion

Pour utiliser la fonction DMS, il faut passer a l'onglet "DMS". Le DMS est activé en usine. Sur la
page d'information (Mode Gestion/DMS), il est possible de voir combien de périphériques ont été
détectés dans le réseau, combien d'entre eux sont en ligne (actifs) ou hors ligne (inactifs).

Les périphérigues hors ligne sont ceux qui ont été soit éteints, soit qui sont en panne (terminal
défectueux) ou qui ne sont plus disponibles sur le réseau (par ex. I'ordinateur portable de service
gue l'installateur emporte chez lui aprés avoir terminé la configuration).

Pour pouvoir utiliser le DMS, un switch doit étre défini comme Master dans le réseau. Ce switch
recueille toutes les informations et les transmet a tous les switches compatibles DMS du réseau.
Le champ Controller IP indique quel switch (adresse IP) posséde la fonction Master.

RY-LGSP23-28/370 X RY-LGSP16-10 X RY-LGSP23-10G x [+

< c @ ® 192.168.1.9, _mode.htr R 4 N @ =
£¥ Meistbesucht @ Erste Schritte
5 ‘1 3 I § 13 25 26 27 28
Y barox:= L 858025 28288 mmmm ® e
2% 6 8 1012 14 16 18 20 22 24
RY-LGSP23-28/870 | | . -
Switch
Mode Enabled |v
> DMS Mode
Controller Priority High |v
& Management v
> Map API Key Total Device T
> Device List On-line Devices s
5 Graphical Monitoring < Off-line Devices 0
£ Maintenance ¢ Controller IP 192.168.1.9
=z
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Détermination du Master DMS :

Sur le switch qui doit étre le Master, il faut choisir le mode "High" dans le champ "Controller
Priority". Il est recommandé de définir le switch le plus puissant pour cette tache, car le DMS
nécessite de la capacité de calcul supplémentaire. Les autres switches du réseau peuvent étre
classés "Mid" ou "Low" en fonction de leurs performances. Pour qu'un switch ne devienne jamais
Master DMS, la Controller Priority doit étre réglée sur "Non".

Ou, si la charge du réseau est trés élevée, le DMS peut étre mis en marche sur le switch le
moins fréquenté et désactivé sur les autres switches. Il est a noter que certaines fonctions

sont limitées et que cette méthode est recommandée pour une structure homogéene avec
des switches barox.

Sur la ligne "Controller IP", I'adresse IP indique quel switch est le Master.

Device List

Cette page répertorie tous les périphériques en ligne ou hors ligne du réseau. Le type d'appareil,
I'état, le nom du périphérique ainsi que l'adresse MAC et I'adresse IP sont listés sous forme de
tableau.

Tous les périphériques - y compris ceux dont les adresses IP sont situées dans un segment de
réseau différent - sont répertoriés.

Cette fonction est particulierement utile lorsqu'un périphérique non configuré est intégré dans le
réseau et que l'adresse IP est inconnue.

. 1u13:51627za 2 2
) ba rox = L OeEnEE BESEE mm— M ecoc
2 4 6 & 1012 14 16 18 20 22 24
RYCLGSE2328/8708 e ices List @Home Device List
Switch DMS
Auto-refresh {4 En
> DMS Mode
Show 10 |v entries Search:
€ Management v
[[] Remove Status Device Type Model Name Device Name MAC IP Address
> Map API Key
5> Device List @ Online SWITCH RY-LGSP16-10 Switch 2 38-B8-EB-20-34-62 192.168.1.1
% Graphical Monitoring < ® Online SWITCH RY-LGSP23-10G Switch 3 38-B8-EB-20-38-17 192.168.1.2
£ Maintenance < @ Online SWITCH RY-LGSP23-28/370 Switch 1 38-B8-EB-20-06-41 192.168.1.9
® Online IP Camera AXIS P1447-LE Kamera 1 AC-CC-8E-C7-9C-  192.168.1.41
D5
@ Online IP Camera AXIS P1447-LE Kamera 3 AC-CC-8E- 192.168.1.42
C8-37-3A
® Online IP Camera AXIS P1447-LE Kamera 2 AC-CC-8E-BB- 192.168.1.43
AB-85
® Online PC General PC Technik 30-85-A9-6F-31-DE  192.168.1.111
Showing 1 to 7 of 7 entries

En cliquant sur le symbole d'état "Online" ou "Offline", la connexion au périphérique peut étre
vérifiée - méme lorsqu'elle passe par plusieurs switches.
S'il y a une interruption dans la chaine de connexion, vous pouvez le voir ici.

Le méme contrdle peut étre effectué a partir du menu "Maintenance/Diagnostics".
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Select

barox Kommunikation

Diagnostics

Show| 10 entries

* Status

@ Online

Showing 1to 6 of 6 entries

92.168.1.9 38-b8-eb-20-06-41

92.168.1.1 38-b8-eb-20-34-62

Cable status.... @

192.168.1.43 ac-cc-Be-bb-26-85

Model Name

AXIS P1447-LE

25

Device Name

Kamera 2

H e c

@Home - Maintenance - Diagnostics

Search:

MAC IP Address Version

AC-CC-8E-BB-A6-85  192.168.1.43



4.2 Monitoring Graphique

Vue Topologique

Dans la vue topologique (Topology View), le réseau, y compris tous les terminaux IP connectés,
est automatiquement affiché sous forme graphique. Si le terminal est reconnu correctement, le
symbole correspondant (caméra, switch, point d'acces, etc.) s'affiche. Toutes les informations
telles que le nom du périphérique, I'adresse IP, le débit de données, etc. apparaissent
parallelement au symbole. Tous les réglages peuvent également étre configurés manuellement.

7 5 11 131517192123 25 26 27 28

e
= : I )
) harox= i, % e C
BlilllllLllie

RY-LGSP28-28/370 | 1,.,1/00y View

Switch DMS

~ =
> DMS Mode @) Kamera 1
% Management < E3] 192.168.1.41
= Port:2 0.001Mb)
«& Graphical Monitoring v ¥
> Topology View Technik
> Floor View General PC
. N 192.168.1.111
> Map View Port. 7 (0.007Mb)
# Maintenance <

Switch 1 Switch 2 Kamera 2
RY-LGSP23-28/370 RY-LGSP16-10. AXIS P144T-LE
192.168.1.9 192.168.1.1 192.168.1.43

Port: 23 - Port: 7 Port: 3 (0.001Mb)

Switch 3 Kamera 3
RY-LGSP23-10G AXIS P1447-LE
192.168.1.2 192.168.1.42

Port: 24 - Port: 10 Port: 1 (0.001Mb)

Un clic sur le symbole affiche le "Tableau de bord" (Dashboard) de périphérique correspondant.

Dans le "Dashboard", il est possible de définir le type et le nom du périphérique, les adresses
MAC et IP ainsi que de consulter les exigences PoE affichées en temps réel, a condition qu'il
s'agisse d'un consommateur PoE.

En outre, il est possible d'accéder directement au périphérique via "Login" ou d'effectuer un
diagnostic de connexion. Le fait de cliquer sur I'icbne "PoE Reboot" permet un redémarrage
du consommateur PoE sans aucun probléme.

Pprt: 2 - Port 1 100 180 205 50

Axis M1114 X

01Mb)

Device Type General IP Cam [~

Device Name | Axis M1114

00-40-8c-bS-f1-85

P 192.168.1.10
[
Http P |80
RY-LGSP23-10G &
192.168.1.2 | gzmym | POF Used 3w 10
Port: 2~ Port: 1 g 3 ; | p82Mb)
RY-LGSP23-28/370 O
L,. Legin Diagnostics PoE
192.188.1.9 =B i
eboot
Notification Monitor

Port: 4 - Port: 23
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Si un périphérique

- était temporairement indisponible (erreur de céble, déconnexion du consommateur, etc.),
- n'était pas immédiatement lisible via ONVIF

- avec une adresse IP déja existante était connecté

- etc.

un numéro rouge apparait a c6té du symbole. Le chiffre rouge indique combien de messages
sont disponibles pour ce périphérique.
Les messages peuvent étre lus et édités dans le menu "Notification".

1mc amm o

Axis M1114 X

A
& 2011-01-01 05:41
(® Device Off-ine is caused by cable disconnection

RY-GSP22-26/370

=B 192.168.1.11
Port: 1 - Port: 1

2 =

Dashboard ! Monitor

Si un périphérique n'existe plus dans le réseau, il est affiché en rouge dans la vue topologique et
le symbole "Remove" apparait dans le "Dashboard". En cliquant sur "Remove", le périphérique
est finalement retiré de la vue topologique.

Il faut impérativement cliquer sur "Remove" si, par exemple, une caméra défectueuse doit étre
remplacée par une nouvelle caméra avec la méme adresse IP. Le switch stocke non seulement
l'adresse IP mais aussi I'adresse MAC. Si I'ancienne adresse IP n'est pas supprimée via la
fonction "Remove", le switch s'attend a ce que l'ancienne caméra soit réinitialisée avec la
combinaison d'adresses IP et MAC d'origine et régle encore et toujours la nouvelle caméra sur
I'adresse IP par défaut malgré une méme adresse IP. Cela se produit parce que la nouvelle
caméra a une adresse MAC différente.

18 ama 2

Axis M1114 X
Axis M1114
RY-LGSP23-10G 0 Axis M1114
19216312 (== )& 152.168.1.10
00-40-8¢-bS-11-85 Pple -t LS
192.168.1.10

80

X X

Remove Diagnostics

Notification Monitor
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asre ascw g

Axis M1114 X

Autre outil utile : la fonction "Monitor".

Ici, le flux de données (par ex. d'une caméra) est v
affiché en temps réel. g

Min(Mb) et Max(Mb) peuvent étre utilisés pour définir
les seuils dans lesquels le flux de données doit se

déplacer. Il est donc aisé de voir en un coup d'ceil si :
tout fonctionne bien. 5 :

€0 [
(Sec) ¥

Min(b): [0 Max(Mb): D !

{Mb)

A fat]

Dashboard Notification Monitor

En haut a droite de la vue topologique se trouve une icdne qui liste tous les périphériques
"Device".

Si vous cliquez sur une entrée de la liste, le périphérique correspondant est marqué en bleu
dans le diagramme de réseau.

fl

7 9 11 13 15 17 2%

- nz
= H I T YT 1 Y
) barox = L Neeeee e Meco
el

RY-LGSP23-28/370 Topology View
Switch DMS

~ 2z Device | 4 Group | F Config
< > = )
> DMS Mode - Kamera 1 (an [~] @& [sve [
AXIS P1447-LE
£ Management < Haznoael ‘
= Port: 2 (0.0011b) s
% Graphical Monitoring v ¥

> Topology View
> Floor View

> Map View Port: 7 (0.007Mb)

Swich 1 Switch 2 Kamera 2
RY-LGSP23-28/370 RY-LGSP18-10 AXIS PI44T-LE
192.168.1.9 192.168.1.1 192.168.1.43

Port: 23 - Port: 7 Port: 3 (0.001Mb)

# Maintenance <

L'outil offre également la possibilité d'imprimer le plan de réseau au format SVG, PNG ou PDF
directement depuis la vue topologique. Pour ce faire, il suffit de sélectionner le format désiré
puis de cliquer sur I'icone de la caméra.

La vue topologique (Topology View) offre également la possibilité d'afficher la constellation en
anneau. Pour cela, il faut sélectionner la liste "Switche" dans le registre "Device". L'anneau est

alors affiché et une ligne pointillée rouge indique quel itinéraire et quels ports sont définis
comme ports alternatifs.

Deux conditions doivent étre remplies pour cette représentation :

a) RSTP en tant que protocole en anneau
b) L'anneau se compose uniquement de switches RY qui supportent DMS
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> barox=

RY-LGSP23-28/370 Topology View
Switch DMS

~
> DMS Mode Sy
v
£ Management < x|
=
% Graphical Monitoring v ¥

> Topology View
> Floor View

> Map View

# Maintenance <

Floor View

5 7 5 11 131517192123

Switch 2
RY-LGSP16-10
192.168.1.1

Switch 1
RY-LGSP23-28/370
192.168.1.9

Switch 3
RY-LGSP23-10G
192.168.1.2

Port: 24 - Port: 10

H e &

@rome Topology View

o)
5|
ol 2
i

-] @& [sve

e | eroup | fconfig

@ FlE

® @

La Floor-View permet de visualiser les plans de batiment, d'étage et/ou d'environnement
téléchargés ou importés. Ceux-ci servent de base ou d'image de fond pour cartographier le
réseau. Cette fonction constitue une bonne aide a l'orientation pour les applications sur site

et peut également étre imprimée comme documentation, comme décrit ci-dessus.

RY-LGSP23-28/370 Floor View
Switch DMS
> DMS Mode € >
& M t
lanagemen < =l
&% Graphical Monitoring v
> Topology View
> Floor View
> Map View
# Maintenance <

107 168 1 linday htm

ry Al
2 10 12 14 16 18 20 22 2

Gemeinde-
81 buol i

Ausstelung 02
\

Nr.2
Jokobischhof 1 Gemendercume
Jokobirchhof 2

[}
@

~

Pour placer la caméra ou le switch sur le plan, il suffit de sélectionner le périphérique
correspondant dans la liste avec un clic de souris et de le placer sur le plan. Rien de plus.

Map View

Mo
@Home
L & Config
m &
Stockwerkplan L oo v
[ ]
7=
= °
@ °
~
=) °
e
® =
<§ o
°
°

La méme fonction est possible avec la Map View. Ici, I'image de fond est générée avec Google

Maps. Toutefois, une connexion Internet et des licences Google sont nécessaires pour utiliser le

service.
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4.3 Maintenance

Pour utiliser un plan comme image d'arriére-plan, il faut se rendre dans le menu "Maintenance".

Dans le menu "Floor Image", il faut saisir le chemin d'acces et le nom du fichier et les
télécharger en cliquant sur "Add".

: —— i = ™ T
) barox = L Seneus suwew A
Tl

RY-LGSP23-28/370 Image Management

@ome Hioxbrage

Switch DMS

Maximum: 30 files Used: 0 file(s) Free: 30 file(s)

> DMS Mode
# Management < AddFloor Image: Durchsuchen... | Stockwerkplan jpg
& Graphical Monitoring < = Name Stockwerkplan 0G
# Maintenance v m

> Floor Image

> Diagnostics

Select No.

File Name Image
> Traffic Monitor

No information found

Les plans importés sont listés sur le bas de la page Web. Il est possible d'enregistrer jusqu’
a 50 fichiers.

> barox-=

(2 s
RYLGSRISSBION Image Management @ome P
Switch DMS
Maximum: 30 files Used: 1 file(s) Free: 29 file(s)
> DMS Mode
# Management < AddFloor Image: Durchsuchen... | Stockwerkplan jpg
% Graphical Monitoring < Name Stockwerkplan
/& Maintenance ~ m
> Floor Image
> Diagnostics.
Select No. File Name Image
> Traffic Monitor
O 1 Stockwerkplan OG (192.168.1.9) ,.-,__f
r N s
s &
A
SN

Diagnostic

Cette fonction a été décrite et expliquée a la page 23 sous la rubrique "Device List".
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Traffic Monitor

ATTENTION : La surveillance du trafic n'est pas supportée par les switchs industriels.

Le traffic monitoring (surveillance du trafic) est un autre outil de diagnostic trés utile. Le menu
"Maintenance" affiche le trafic de chaque port sur 24 heures.

Le graphique a barres sur le haut montre chaque port et toutes les données envoyées et recues

via le port pendant la journée. Il peut étre sélectionné par date, par jour ou en vue
hebdomadaire.

Si I'on clique maintenant sur la barre d'un port, une échelle de 0 a 23 heures dans le diagramme
du bas indique I'heure a laquelle les données ont été transmises, en en quelle quantité.

Ceci peut étre trés utile lors du dépannage, par exemple lorsque I'on remarque qu'a 12h du
matin beaucoup de trafic a été généré sur le port 2 et qu'il y avait des problémes
d'enregistrement.

> barox-=

RY-LGSP23-28/370 ' . i Monitor

Switch DMsS

VIO TR TR 4 2019/05/07 @Qosy ek A Device List ) R

> DMS Mode
& Management <

« Graphical Monitoring <

& Maintenance ~

2000 M-

> Floor Image
1600 M~

> Diagnostics 1000 M~

> Traffic Monitor 500 M~

oM——
1oz

3 4 5 e 7 8 9 10 M 12 13 14 15 16 17 18 19 20 21 22 23 24 25 28 27 28 Port
Kamera 1 [VECUHES

ts00 M=
1e00m-
1400 m
1200 -
10001
s00 -
coom
s0m-

200m 3
Time

% | (Hour)

oM

o 1 2 3 4 5 6 7T 8 9 10 1 12 13 14 15 16 17 18 19 20 21
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5 La gestion des switches au coeur de la sécurité

Les rubriques suivantes sont destinées a fournir des informations sur le contenu et la
configuration des parameétres réseau avancés et la sécurité. Les prérequis de base pour la
configuration sont les connaissances et les compétences en matiére de mise en service telles
gue la configuration IP, la connexion et la configuration VLAN.

5.1 Gestion et protection au niveau du switch (couches 1 et 2)

5.1.1. Parametres et limites de la bande passante
Réglage par port Ethernet

Dans certains cas, il est nécessaire de sélectionner manuellement la norme ETH requise. Par
exemple, lors de la connexion de composants réseau qui ne permettent pas la négociation
automatique de la norme ou qui nécessitent une révision a la baisse de la norme ETH en raison
de certaines conditions de fonctionnement. Comme indiqué ci-dessous, les réglages
10/100/1000/10000 FDX/HDX (la norme ETH dépend du modele), sélectionnables pour chaque
port, peuvent étre ajustés via le GUI Web.

RY-LGSP23-26 Ports Configuration

Switch DMS
a
£+ Configuration v
» System < Speed
» Green Ethernet ¢ Port Link Current Configured
» Ports Configuration v N
> Ports - -
> Ports Description 1 . Down Auto y
» DHCP <
» Security < 2 . Down CAuto e
» Aggregation <
> Loop Protection 3 1Gfdx Auto ~

Certaines applications nécessitent I'adaptation de la taille des trames Ethernet. Ceci peut
également étre fait dans le menu "Ports Configuration" dans le champ "Maximum Frame Size",
comme dans la capture d'écran suivante.
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RY-LGSP23-26 Ports Configuration

£+ Configuration v

Switch DMS

» System < Speed

» Green Ethernet < Port Link Current
» Ports Configuration ~

> Ports

> Ports Description 1 . Down
» DHCP <

» Security < 2 . Down
» Aggregation <
> Loop Protection 3 1Gfdx

Configured

<

Auto

Auto

Flow Control
Current Rx

| @
| 9

Current Tx

]
]
@

Configured

O

]
]
g

@Home

Maximum Frame Si

9600

9600

9600

9600

Il est important de respecter les valeurs exactes lors du réglage de la taille de la

trame afin d'éviter les dysfonctionnements !

5.1.2. Notes sur la prise en compte générale des besoins en bande passante

Lors de la planification des besoins en largeurs de bande et de I'utilisation de switches barox

appropriés, il est conseillé de prendre en compte les points suivants :

- Utilisation des normes Ethernet requises (10/100/1000/10000) en tenant compte
d'éventuelles upgrades des terminaux.

- Planification de réserves, mises a I'échelle au niveau de la performance de commutation

Backplane du modéle -> on recommande souvent 30 %.

- Lors du calcul des besoins, tenez compte de la spécification Ethernet maximale par

terminal.

5.1.3. Protection des ports via les parameétres de configuration MAC

La table MAC

En principe, la table MAC peut étre ajustée aussi bien manuellement qu'automatiquement. Ceci
est généralement nécessaire si certains terminaux réseau requiérent une affe ctation statique par
rapport au VLAN et au port. En outre, |'affectation manuelle peut étre utilisée pour mettre a
I'échelle une protection de base ou une restriction d'acces.

Filtrage MAC et configuration des ports

Exemple de configuration Table MAC statique :

L'appareil avec l'adresse MAC A1:00:00:00:00:FF ne doit pouvoir établir une connexion qu'au

port 5 du VLAN 1.

1. Sélectionner "Add New Static Entry" dans le menu Switch -> Configuration -> MAC

Table

2. Entrer I'ID VLAN, l'adresse MAC et régler I'élément de port 5 sous "MAC Table

Learning" sur "Secure".

3. Confirmer les données saisies avec "Apply"
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La capture d'écran suivante sert d'illustration.

MAC Address Table Configuration

Aging Configuration

Disable Automatic Aging ]

Aging Time 300 seconds

MAC Table Learning

Port Members

1 2 3 4 5 6 7 8 9 10 11 12 13 14
Ao @ O @ O 9 9 9 9 99 9
Disable

Secure (V]

Static MAC Table Configuration

Port Members

Delete VLANID MAC Address 1.2 3 4 5 6 7 8

B3 |[eew=#|00008000

€

Add New Static Entry

La protection par filtrage MAC offre une protection simple contre les accés indésirables au
réseau. Néanmoins, elle ne protége pas contre l'attaque répandue du "MAC Spoofing", par
exemple.

5.1.4. Sécurité des ports avec parameétres de Limit Control

Si des switches non gérés avec des terminaux sont connectés au switch barox, il est
recommandé d'utiliser le Limit Control. Cette fonction empéche en principe les autres terminaux
IP/Ethernet indésirables d'avoir acceés a la communication réseau sur les ports libres des
switches non gérés. Pour des raisons de planification, il faut déterminer le nombre total de
terminaux réseau, y compris le switch non géré connecté au port correspondant du switch barox.
Exemple : Si un switch non géré avec 3 autres terminaux réseau est connecté au port 2 du
switch barox, le nombre total de la limite est de 4. La configuration doit d'abord étre activée.
Ensuite, on active le port correspondant, on fixe la limite et on active I'action sélectionnée

en cas de dépassement. L'apprentissage des terminaux est activé et rendu possible par la
fonction "Sticky". Lors de la configuration, il est nécessaire que les appareils soient
physiquement connectés au switch barox au niveau du port & configurer. Vous trouverez
ci-dessous une illustration des réglages.
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Port Security Limit Control Configuration @Home - Configuration - Security - Network - Limit Control
Switch H

System Configuration

Mode Enabled

Aging Enabled [l

Aging Period 3600 seconds

Port Configuration

Port Mode Limit Action State Re-open Sticky Clear

- o 4 © ©

1 Disabled 1 None Disabled Disabled
2 Enabled 4 Disabled Disabled

5.2 Utilisation et protection des fonctions IP (couche 3)
5.2.1. Serveur DHCP

Remarques sur l'utilisation de serveurs DHCP dans les réseaux vidéo

Il est important de vérifier si 'utilisation d'un serveur DHCP est généralement nécessaire
du point de vue de la conception du réseau. En plus des avantages de la distribution
automatisée de l'information réseau, ce service offre également un large éventail de points
d'attaque.

Configuration de base et mise en service du service DHCP al'aide de I'exemple
suivant
La portée VLAN du service est d'abord définie et le service est généralement activé dans

le Mode avec le paramétre Enabled activé, puis activé avec confirmation comme illustré
ci-dessous.

DHCP Server Mode Configuration

VLAN Mode

Delete VLAN Range Mode

10 -1 10 Enabled

Add VLAN Range

Voici les parameétres du pool d'adresses IP qui doit permettre la distribution de 50 adresses
dans l'exemple, c'est-a-dire des adresses dans la plage 192.168.10.100 - 192.168.10.150, en
spécifiant les adresses ou plages IP environnantes (procédure d'exclusion) aux clients IP dans
le VLAN en question.
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DHCP Server Excluded IP Configuration

Switch

Excluded IP Address

Delete IP Range

192.168.10.1 -| 192.168.10.99
m 192.168.10.151 -| 192.168.10.254|

Add IP Range

Un nom du service DHCP est ensuite défini et confirmé.

DHCP Server Pool Configuration @Home - Confeur
Pool Setting
Delete Name Type IP Subnet Mask Lease Time

Add New Pool

Une fois le nom défini, on va chercher les réglages en sélectionnant le nom comme indiqué
ci-dessous.
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DHCP Server Pool Configuration

Switch

Pool Setting

o

Delete Name Type 1

[] test - -

Add New Pool

Une fois le nom du pool sélectionné, la configuration apparait comme indiqué ci-dessous.

DHCP Pool Configuration

Switch
Pool
Name ‘
Setting
Pool Name
e
.
Subnet Mask

Pour faciliter I'illustration ou pour la compréhension, seuls les réglages indiqués ci-dessus sont
nécessaires et confirmés par la confirmation de la configuration en fin de page.
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5.2.2. Protection du DHCP par inspection ARP

La protection contre les clients DHCP indésirables peut étre réalisée avec l'inspection ARP.
Une fois les fonctions activées, les clients DHCP peuvent étre gérés statiguement en tant que
destinataires dans un tableau. La condition de base pour une sécurité maximale est que la taille
du pool d'adresses DHCP soit définie en fonction du nombre de clients.

Tout d'abord, la fonction Snooping est généralement activée dans le menu Snooping Mode,

comme illustré ci-dessous. Vous pouvez également sélectionner le degré de confiance pour
les ports du switch. Pour la fonction Inspection, le mode doit étre réglé sur "Trusted".

DHCP Snooping Configuration

Snooping Mode Enabled
Port Mode Configuration

Port Mode

* <> ]
1 Trusted |

Les parametres des ports sont également activés et configurés. Dans I'exemple ci-dessous,
I'inspection ARP est activée pour le port 3, le contréle VLAN est activé et le type de Log
est réglé sur "Deny".

ARP Inspection Configuration @Home - Configuration - Security > et
Switch

Mode Enabled

Translate dynamic to static

Port Maode Configuration

Port Mode Check VLAN Log Type
:

> ~ <> ~ > ~
1 Disabled Disabled None
2 Disabled Disabled None
4 Disabled Disabled None
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Ensuite, les VLAN a inclure dans le contréle sont définis et le type de Log (degré de confiance)
sont définis comme indiqué ci-dessous.

VLAN Mode Configuration @ttome - Cor
o] <] ]

Start from VLAN | 1 , 20 entries per page.

Delete VLAN ID Log Type

Add New Entry

Une fois les réglages effectués, les clients DHCP peuvent étre connectés. Une fois que le
service DHCP a distribué les adresses IP, les clients ayant des propriétés Layer2 et 3 sont
visibles dans le tableau dynamique d'inspection ARP et peuvent ensuite étre reportés dans
le tableau statique d'inspection ARP.

Dynamic ARP Inspection Table @bHome - Configuration > Security > Metwork = ARP Inspection
Switch
Auto-refresh H
Startfrom  Port1 ,VLAN | 1 , MAC address | 00-00-00-00-00-00 and IP address  0.0.0.0 , 20 entries p

System Configuration

Port VLAN ID MAC Address IP Address Translate to static

3 2 5c-9a-d8-5¢-98-1¢ 192.168.11.50
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Une entrée statique est présentée ci-dessous. L'adresse IP est réservée au client selon

le tableau.

Static ARP Inspection Table
Switch

@Home > Configuration > Security = Network > ARP Inspection

Delete Port VLANID
3 2
Appl) R# et

5.2.3. IP Source Guard

Déploiement et configuration

MAC Address

5c-9a-d8-5¢-98-1¢c

IP Address

192.168.11.50

L'utilisation de la fonction IP Source Guard représente une fonction étendue pour sécuriser le
cOté du terminal. Ceci lie non seulement la recherche de I'adresse MAC du terminal source mais
aussi l'adresse IP statique des périphériques connectés.

Comme indiqué ci-dessous, cette fonction est généralement activée et peut étre ajustée pour

chaque port.

IP Source Guard Configuration

Switch

Mode

Translate dynamic to static

Enabled

Port Mode Configuration

Port Mode

*
<]

<z

1 Disabled
2 Disabled
3 Enabled
4 Disabled
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Une fois la fonction mise en marche, la configuration peut étre effectuée avec des entrées
statiques, tel qu'illustré ci-dessous.

Static IP Source Guard Table
Switch

Delete Port VLAN ID IP Address MAC address
Delele 3 10 192.168.10.40 A1:00:00:00:00:FF|

Add New Entry

Appl) Reset

L'utilisation d'IP Source Guard permet d'étendre la fonction de sécurité en sécurisant le port
avec des adresses MAC et IP. Par rapport a Port Security, ou les entrées d'adresse MAC
statiques par port sont censées empécher une éventuelle attaque, I'lP Source Guard, avec des
entrées statiques, offre, en plus de I'état du périphérique connecté, une vérification de I'adresse
IP. Si les conditions, I'adresse MAC et I'lP assignées sur le port de I'appareil connecté, ne sont
pas remplies, le switch bloguera la communication réseau sur le port. Cela signifie que
I'attaquant doit connaitre I'adresse MAC et I'adresse IP du périphérique pour accéder au réseau.

@Home - Configuration > Security > Netu

5.3 Protection de la gestion des switches et administration réseau (couches 3-7)
5.3.1. Administration et configuration des utilisateurs
Créer un utilisateur

Vous trouverez ci-dessous un exemple de création d'un autre utilisateur.

Add User

Switch

User Settings

User Name
Password
Password (again)

Privilege Level

barox Kommunikation 41

test




Paramétres de base des directives et privileges utilisateur

- Les niveaux de privileges (Privilege Levels) sont utilisés pour graduer les droits aux
parametres de configuration ou a la lecture et I'écriture des valeurs. Il est recommandé
de ne pas modifier les valeurs par défaut, mais de les affecter lors de la création de
nouveaux utilisateurs.

- Remarque : Il est utile d'adapter les droits d'un autre utilisateur en fonction de ses
habilitations et compétences.

RY-LGSP23-26

Privilege Levels Configuration @Home Priviege Levels
Switch DMS
Privilege Levels
£ Configuration v
- Group Name Configuration Read-only Configuration/Execute Read/write Status/Statistics Read-only Status/Statistics Read/write
» System <
» Green Ethemet ¢ ACTIVATE 5 |v 10 v 5 |v 10 v
» Ports Configuration <
Aggregation 5 v 10 |v 5 v 10 |v
» DHCP <
» Security v cloud_management 5 |v 10 |v 5 |v 10 |v
» Switch v
Debug 15 v 15 |v 15 |~ 15 |v
> Users
> Privilege Levels DHCP 5 v 10 |v 5 |~ 10 |v

5.3.2. Utilisation et paramétrage de I'authentification au niveau de la gestion des switchs
Protection de I'accés CLI ssh vs. telnet

Comme indiqué ci-dessous, la méthode d'accés peut étre définie ou les fonctions inutilisées
peuvent étre désactivées. Il est recommandé, si la conception du réseau le permet, de

désactiver la fonction d'accés Telnet en général. Les méthodes de configuration peuvent
étre définies comme indiqué ci-dessous.

RY-LGSP23-26

Authentication Method Configuration @Home Auth Method
Switch DMS
Client Methods Service Port
£+ Configuration v
console local ~ no no
» System <
» Green Ethernet < telnet no ~ no no 23
» Ports Configuration 3
» DHCP . ssh local ~ no no 22
» Switch v
5 U5ET https no ~ no no 443
> Privilege Levels
> Auth Method Apply

- Il est recommandé d'utiliser le protocole SSH pour I'administration en ligne de commande
(CLI), car cette méthode fournit la connexion cryptée.
Gestion de I'accés a l'interface web (GUI) avec http
- Il est recommandé de créer un utilisateur séparé pour http

- Maodifier le port 80, Remarque : Respecter les spécifications du port lors de I'accés dans
le navigateur !
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- L'acces HTTP offre la meilleure protection, car la connexion est cryptée.

L'exemple suivant montre la saisie de I'adresse d'administration avec port modifié

192.168.1.1:34 56

La restriction de I'acces a la gestion et de ses méthodes peut étre limitée a certaines plages
d'adresses IP et a certains VLAN. Ceci peut étre fait dans I'Access Management, comme le
montre I'exemple ci-dessous.

RY-LGSP23-26

Access Management Configuration @Home Access Management
Switch DMS
. Mode Disabled |+
£+ Configuration ~
» System <
Delete VLANID Start IP Address End IP Address HTTP/HTTPS SNMP TELNET/SSH
» Green Ethemnet <
» Ports Configuration < ! 192185110 192168111
» DHCE < 10 192 16810 40 192 168 10 41| ‘ O O
» Security ~
> Users
> Privilege Levels
> Auth Method
» HTTPS

> Access Management
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5.3.3. Gestion des accés et utilisation de HTTPS
La possibilité de paramétrage de I'utilisation du protocole HTTPs est également illustrée.

M e .
Authentication Method Configuration @Home - Configuration - Security - Suitch - AuthMethod
Switch

Client Methods Service Port

console local . .

telnet no no ho 2

ssh focal no no »

http focal no no 80

htips - no 443

Le port normalisé peut également étre modifié avec cette méthode.

Si le mode est activé, I'option http doit étre désactivée. La GUI du switch est appelée dans

le navigateur a l'aide de la phrase de protocole HTTPs https://192.168.XX(votrelP de
gestion):1234(votre port) dans le champ URL. Une fois définie, la communication du navigateur
avec l'interface de gestion est cryptée.

5.3.4. Configuration et déploiement de I'accés a la gestion basé sur les certificats

Bréve remarque sur l'utilisation des certificats :

Une connexion basée sur un certificat permet I'un des plus hauts niveaux de protection d'acces
pour les services de configuration en réseau. Néanmoins, l'utilisation doit étre vérifiée, car la
connexion a la gestion ne peut se faire que par l'intermédiaire des supports qui ont intégré

le certificat.

Les options et méthodes de réglage sont indiquées ci-dessous.

H-I_rPS Conﬂguratlon @@ Home = Configuration = Security = Switch = HTTPS
Switch

Certificate Maintain Benerate

Certificate Status Switch secure HTTP certificate is presented
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- Génération du certificat pour une utilisation ultérieure, qui peut étre téléchargé et installé
via le navigateur.

RYLGSFE23-26 1 7TPs Configuration @rome
Switch DMS
Certificate Maintain Upload v
& Configuration v
» System . Certificate Pass Phrase cessescass
3 ETEEDBITETIE € Certificate Upload Web Browser .
» Ports Configuration <
» DHCP . File Upload Keine Datei ausgewdhit.
» Security ¥ Certificate Status Switch secure HTTP certificate is presented
» Switch v
> Users Apply

> Privilege Levels
> Auth Method
> HTTPS

- Téléchargement d'un certificat généré en externe

- L'accés au navigateur a lieu aprés l'installation du certificat et la définition de la méthode
d'authentification HTTPs via le protocole HTTPs.

5.4 SNMP - Fonction de surveillance et d'administration

SNMP a été développé par I'lETF (Internet Engineering Task Force) et sert de protocole pour
surveiller, contrdler et configurer les éléments du réseau.

5.4.1. Configuration SNMP v2c

Ci-dessous, un exemple décrit une configuration de base SNMP v2 pour l'interrogation de I'état
du systéme ou I'envoi d'événements systéme via des Traps SNMP. Les étapes suivantes sont
destinées & démontrer I'utilisation d'une Community SNMP.

Activation de la fonction SNMP v2

En principe, le mode doit étre activé et la version SNMP v2 doit étre sélectionnée dans
la configuration SNMP. Les noms des Communities Read and Write sont également définis.
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2 bharox= .l

RY-LGSP23-26

SNMP System Configuration @ tome
Switch DMS
Mode Enabled v
£+ Configuration v
» System . Version
» Green Ethernet < Read Community barox
» Ports Configuration <
» DHCP ¢ Write Community barax
» Security v .
Engine ID 800007e50171000001
» Switch v
> Users
Apply

> Privilege Levels

> Auth Method

> HTTPS

> Access Management

» SNMP -

> System

5.4.2. Configuration de la Trap SNMP

Avant de configurer les nouveaux réglages Trap, assurez-vous que le réglage global du mode
Trap est désactivé.

1 3 5 7 9 11 13 15 17 19 21 23
— : ) ol
) ba rox = ‘o WYY Weww 8 04%%

RY-LGSP23-26

Trap Configuration @Ho
Switch DMS
Global Settings
£+ Configuration v
» System ¢ Mode Disabled |v
» Green Ethernet <

» Ports Configuration ¢ Trap Destination Configurations

» DHCP <
: Delete Name Mode Version Destination Addres
» Security v
» Switch v
> Users

> Privilege Levels Apply -

> Auth Method

> HTTPS

> Access Management

» SNMP v
> System
> Trap

nouvelle configuration s'effectue en 2 étapes :
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Etape 1:

L'exemple suivant montre comment définir les valeurs suivantes pour une nouvelle
configuration :

- Trap Config Name -> Un nom doit étre attribué
- Trap Mode -> UDP ou TCP — au début, UDP comme d'habitude
- Trap Version -> Sélection de SNMP v2c
- Trap Community -> Le nom de la Community précédemment créé doit étre entré
- Trap Destination Address -> Saisie de I'adresse IP du destinataire Trap
- Trap Destination Port -> Saisie du port pour le destinataire
- Trap Inform Mode -> Sur "désactivé" dans le présent exemple
- Trap Inform Timeout (seconds) -> La valeur 3 est entrée (standard)
- Trap Inform Retry Times -> 5 (standard)

Les réglages sont ensuite confirmés avec "Apply"

1 3 5 7 9 11 13 15 17 19 21 33
— : [T T W Ty T ryrs
> barox-= .= $8333280 550845

10 12 14 16 18 20 22 24

RY-LGSP23-26

SNMP Trap Configuration @ Home
Switch DMS
Trap Config Name test
£+ Configuration v
» System . Trap Mode UDP -
» Green Ethernet < Trap Version SNMP vZe v
» Ports Configuration <
» DHCP 2 Trap Community barox
» S v
ecurity Trap Destination Address
» Switch -
> Users Trap Destination Port 162
> Privilege Levels
Trap Inform Mode Disabled |v
» Auth Method
> HTTPS Trap Inform Timeout (seconds) 3

> Access Management
Trap Inform Retry Times

]

» SNMP v
> System Trap Probe Security Engine ID Enabled
> Trap
> Communities Trap Security Engine ID
> Users Trap Security Name None
> Groups
> Views Apply

s Arroce
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Etape 2 :

Apres avoir créé la nouvelle configuration, on ouvre la configuration en sélectionnant le nom.

!ﬂ?-- T "'“.jlﬁg

8 10 12 14 16 1i

Trap Configuration f

Global Settings
Mode Disabled

Trap Destination Configurations

Delete Name Mode Version Destination Ad

[l test ubpP SNMPv2c 192.168.10.

Add New Entry

Activation de la fonction Trap SNMP

Une fois la configuration Trap terminée, le mode général doit étre active.

> barox=

Trap Configuration P!
Switch

Global Settings

Mode

Trap Destination Configurations

Delete Name Mode Version Destination Ad

] test UDP SNMPv2c 192.168.10.1

Add New Entry
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5.4.3. Informations supplémentaires pour I'envoi de Traps SNMP

Assurez-vous que les événements qui déclenchent une Trap sont configurés en conséquence.
Ces réglages peuvent étre configurés ailleurs dans le menu de configuration, comme indiqué
ci-dessous, en fonction du terminal. Certains événements tels que les Port Events doivent
également étre définis en conséquence dans la configuration des ports.

Trap Event Severity Configuration @rome - Con
Switch
Group Name Severity Level Syslog Trap
ACL info
ACL-Log Info
Access-Mgmt Info
Auth-Failed Warning
Cold-Start Warning
Config-Info Info
DMS Info
Firmware- Info
Upgrade
Import-Export Info
LACP Info
Link-Status Warning
Login Info
Logout Info

ATTENTION : Pour les switches industriels, ce réglage se trouve sous
Configuration/System/Alarm Notification.

Vous trouverez de plus amples informations sur la lecture et le test de la configuration au point
"5.6 Lecture des Traps SNMP".
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5.5 Configuration SNMP v3

Situation de départ :

Le besoin accru de sécurité dans le réseau se traduit également par des exigences accrues

en matiére d'administration et de surveillance des composants du réseau. Ceci peut étre fait par
exemple en utilisant la version 3 de SNMP avec authentification. Ci-dessous, un exemple décrit
une configuration de base SNMP v3 pour l'interrogation de I'état du systéme ou I'envoi
d'événements systéme via des Traps SNMP. Les étapes suivantes visent a démontrer
l'utilisation de l'authentification et de la protection par mot de passe.

5.5.1. Activation de la fonction SNMP v3

En principe, le mode doit étre activé et la version SNMP v3 doit étre sélectionnée dans

la configuration SNMP.

> barox=

RY-LGSP23-26

Switch DMS
Mode
£+ Configuration v
» System ) Version
» Green Ethernet <

Read Community
» Ports Configuration <

» DHCP ¢ Write Community
» Securi v
e Engine ID
» Switch v

> Users

> Privilege Levels

> Auth Method

> HTTPS

> Access Management

» SNMP v

> System

Créer une Community dédiée

SNMP System Configuration

'II"II"IF'I 9111:15 1?132:
_ JLJL JLJ LJL JLJLJ L L L JL J %%
2 6 8 2 22 2

6 18 20 Z

#H

Enabled |+~

SNMP v3 v

barox

barox

800007e5017f000001

Lors de la génération de la Community, I'lP source et le masque peuvent rester tous les deux a
0.0.0.0. Cela permet d'envoyer et de recevoir des messages SNMP sur plusieurs sous-réseaux.
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1 3

5 7 9 11 13 15 17 19 21 23
—_ H LT Werr :
> barox:= .= 88888888 88085 5 a

4 2 14 16 18 20 22 24

RY-LGSP23-26

SNMPv3 Community Configuration BHome
Switch DMS

Delete Community Source IP Source Mask

£ Configuration M
ublic
» Systom . ] P 0000 0.0.0.0
» Green Ethernet < ] private 0.0.0.0 0.0.0.0
» Ports Configuration <
» DHCP . ‘ baroy 0000 0000
» Security v
> Users Apply

> Privilege Levels

> Auth Method

> HTTPS

> Access Management

» SNMP v
> System
> Trap

> Communities

Créer un nouvel utilisateur

Lors de la configuration du nouvel utilisateur, veuillez noter que I'Engine ID doit étre ajouté
au nouvel objet utilisateur. Celui-ci peut étre simplement copié et collé a partir de I'entrée
"default_user". En plus de spécifier le nom d'utilisateur, il faut définir le niveau de sécurité,
dans cet exemple "Auth, Priv". Lors de la sélection du protocole d'authentification "MD5" et
du protocole de confidentialité DES, veuillez noter que les deux mots de passe doivent
comporter au moins 8 caractéres (combinaisons de chiffres et de lettres).

1 3 5 7 9 111315 17 19 21 23
—_ H LW rrryr T
> barox:= .= 388848882888 55 °c
RY-LGSP23-26 SNMPv3 User Configuration @tome users
Switch DMS
_ User Security Authentication  Authentication Privacy Privacy
& Configuration ¥ Delete  EngineID Name Level Protocol Password Protocol Password
» System <0 800007€5017f000001  default user NoAuth, NoPriv None None None None
» Green Ethernet <
> Pl Gl . )007€50171000001 barox Auth, Priv v MD5 v sesseseee DES |v
» DHCP <
» Security v
» Switch v Apply
> Users

> Privilege Levels

> Auth Method

> HTTPS

> Access Management

» SNMP -
> System
> Trap
> Communities

> Users
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Créer un groupe

Pour configurer un nouveau groupe dans SNMP v3, sélectionner "usm" comme modele de
sécurité. Sélectionner le nom d'utilisateur précédemment créé comme "Security Name" et
lui attribuer un nom de groupe.

1 3 5 7 9 111315 17 19 21 23

— : TT T T Ty T
arox_ Yy 9wy Peww
2 4 6 8 1012 1416 18 20 22 24

RY-LGSP23-26

» Privilege Levels

usm |v barox v baroy|

> Auth Method

SNMPv3 Group Configuration @tome
Switch DMS
Delete Security Model Security Name Group Name
#+ Configuration v
» System ¢ D vl pUb"C default_ro_group
» Green Ethernet ¢ O vi private default_nw_group
» Ports Configuration <
v2c ublic
» DHCP . O p default_ro_group
» Security - O v2c private default_rw_group
» Switch ~
> Users D usm default_user default_rw_group
s

» Access Management

» SNMP v R
> System

> Trap

> Communities

> Users

> Groups

Paramétrage de la View Configuration

On définit d'abord le View Name. Si tous les messages SNMP pertinents sont visibles, il est
recommandé de régler I'OID sur la valeur ".1". Ceci permet d'avoir une vue compléte de tous
les OID ramifiés.

2 barox-=

RY-LGSP23-26 SMNMPv3 View Configuration &
Switch DMS
Delate View Namea View Type QID Subtreea
& Configuration w
H default_view noius v A
» Syslam 1
= Green Ethemet < -
* Poris Configuration €
= DHCP '] Al Mews Entry
= Sacurity w
» Swilch w m
» Users
» Privilege Levels

Configuration de la méthode d'accés

Pour ce faire, une nouvelle entrée avec la méthode d'authentification et de privatisation doit étre
générée. Sélectionner d'abord le groupe précédemment créé sous "Group Name". Le groupe se
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voit ensuite attribuer le "Security Model" - "usm™ et le "Security Level" - "Auth, Priv". Enfin, pour
la lecture et I'écriture, les Views précédemment créées sont sélectionnées sous "Read View
Name" et "Write View Name".

> barox= ne

SNMPv3 Access Configuration @Home - Configuration - Security > Suitch - SNMP
Switch

Delete Group Name Security Model Security Level Read View Name Write View Name
default_ro_group any NoAuth, NoPriv defaul_view None
default_rw_group any NoAuth, NoPriv default_view defaull_view

Delele barox any Auth, Priv barox

Add New Entry

Appl) Reset

5.5.2. Configuration de la Trap SNMP

Avant de configurer les nouveaux réglages Trap, assurez-vous que le réglage global du mode
Trap est désactivé.

barox=

Trap Configuration @0
Switch

Global Settings
Mode Disabled
Trap Destination Configurations
Delete Name Mode Version Destination Addres
Add New Entry
Apply ﬁ -
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La nouvelle configuration s'effectue en 2 étapes :

Etape 1:

L'exemple suivant montre comment définir les valeurs suivantes pour une nouvelle

configuration :

- Trap Config Name -> Un nom doit étre attribué
- UDP ou TCP - au début, UDP comme d'habitude
- Trap Version -> Sélection de SNMP v3

- Trap Community -> Le nom de la Community précédemment créé doit étre entré

- Trap Destination Address -> Saisie de I'adresse IP du destinataire Trap
- Trap Destination Port -> Saisie du port pour le destinataire

- Trap Inform Mode -> Sur "désactivé" dans le présent exemple

- Trap Inform Timeout (seconds) -> La valeur 3 est entrée (standard)

- Trap Inform Retry Times -> 5 (standard)

- Trap Probe Security Engine ID -> Doit étre désactivé
- Trap Security Engine ID -> L'Engine ID de I'utilisateur doit étre entré ici
- Trap Security Name -> seul "None" peut étre sélectionné pour l'instant

Les réglages sont ensuite confirmés avec "Apply"

> barox:=

RY-LGSP23-26
Switch DMS

£+ Configuration ~

» System
» Green Ethernet
» Ports Configuration
» DHCP
» Security
» Switch
> Users
> Privilege Levels
> Auth Method
> HTTPS
> Access Management
» SNMP
> System
> Trap
> Communities
> Users
> Groups
> Views

> Access

SNMP Trap Configuration

Trap Config Name

Trap Mode

Trap Version

Trap Community

Trap Destination Address
Trap Destination Port

Trap Inform Mode

Trap Inform Timeout (seconds)
Trap Inform Retry Times

Trap Probe Security Engine ID
Trap Security Engine ID

Trap Security Name

103 5 7 9 111315 17 19 21 23
H [T T T Wyl
L LLL LN LLL] %%

8 10 12 14 16 18 20 22 24

test

SNMP v3 ~

barox

192.168.10.100

Disabled |v

e

Disabled |+

800007e50171000001

@ Home

i None

Apres avoir confirmé la configuration, vous serez informé qu'un Security Name correspondant
doit encore étre défini. Ceci sera configuré dans la 2éme étape.
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Etape 2 :

Aprés avoir créé la nouvelle configuration, on ouvre la configuration en sélectionnant le nom.

. i.?-n SAAS AR %%

8 10 12 14 186 22 24

Trap Configuration

Global Settings

Mode

Disabled

Trap Destination Configurations

Delete Name Mode

O test UDP

L'entrée "Trap Security Name" peut maintenant étre réglée sur l'utilisateur SNMP.

Version Des

SNMPv3

SNMP Trap Configuration
Switch

@Home

Trap Configuraton Name

Trap Config Name

Trap Mode

Trap Version

Trap Community

Trap Destination Address
Trap Destination Port

Trap Inform Mode

Trap Inform Timeout (seconds)
Trap Inform Retry Times

Trap Probe Security Engine ID
Trap Security Engine ID

Trap Security Name
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uppP
SNMP v3

barox
192.168.10.100
162

Disabled
3
L

Disabled

800007e5017000001

barox

55



Activation de la fonction Trap SNMP

Une fois la configuration Trap terminée, le mode général doit étre activé.

9 1

13 5 7 113 15 17 19 21 23
— : a0 | oo o ol
) ba rox - . LJLJLJLJ 11‘115 LL Lo

RY-LGSP23-26

Trap Configuration

Switch DMS
Global Settings
£+ Configuration v
» System < Mode
» Green Ethernet <

» Ports Configuration < Trap Destination Configurations

» DHCP <
: Delete Name Mode Version Des
» Security v
» Switch v [] test UDP SNMPv3 1
» Users
> Privilege Levels
> Auth Method Apply
> HTTPS

> Access Management

» SNMP -
» System
> Trap

5.5.3. Informations supplémentaires pour I'envoi de Traps SNMP

Assurez-vous que les événements qui déclenchent une Trap sont configurés en conséquence.
Ces réglages peuvent étre configurés ailleurs dans le menu de configuration, comme indiqué
ci-dessous, en fonction du terminal. Certains événements tels que les Port Events doivent
également étre définis en conséquence dans la configuration des ports.
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L

-
i

1 3 5
—_— : T3
> barox= 888

RY-LGSP23-26

Trap Event Severity Configuration @ Home
Switch DMS
Group Name Severity Level Syslog Trap
£+ Configuration v
ACL Inf v v 4
» System < e . .
» Green Ethernet < ACL-Log Info v
» Ports Configuration ¢
Access-Mgmt v
» DHCP < J e
» Security ¥| Auth-Failed Waming v
» Switch ~
 Users Cold-Start Waming v
> Privilege Levels Config-Info Info .
> Auth Method
> HTTPS DMS o 8
>
Access Management Eirmware- o N
» SNMP b Upgrade
> System
Import-Export Info v
> Trap
> Communities LACP Info v
> Users
Link-Status Warni v v v
» Groups arning . .
> Views Login Info v
> Access
Logout Info v

> Trap Event Severity

Vous trouverez de plus amples informations sur la lecture et le test de la configuration au point
"5.6 Lecture des Traps SNMP".

5.6 Lecture des Traps SNMP

Différents paramétres des configurations des switches barox peuvent étre lus ou réglés via
le protocole SNMP. Pour ce faire, des "navigateurs SNMP/MIB" sont nécessaires. Un logiciel
d'enregistrement / renifleur de réseau peut également étre utilisé pour lire les transmissions
SNMP.

La lecture d'une Trap SNMP v2 vous est expliquée brievement dans I'exemple suivant :
Situation de départ :

Une caméra PoE est débranchée puis rebranchée sur le port Ethernet 3 du switch. Un PC
du réseau est configuré pour recevoir des traps SNMP. Pour la lecture, on utilise le logiciel

Wireshark (https://www.wireshark.org) et pour un affichage ergonomique, le *"MIB Browser
d'iReasonning" (http://www.ireasoning.com/mibbrowser.shtml).
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La caméra PoE est déconnectée / appareil PD hors ligne :

Apercu des informations envoyées par le switch :

[i |snmp [X] ']
Mo, Time Source Destination Protocol  Length Info
347 18.688913 192.168.18.3 192.168.18.168 SNMP 169 snmpV2-trap 1.3.6.1.2.1.1.3.8 1.3.6.1.6.3.1
488 11.783519 192.168.18.3 192.163.18.1688 SNMP 288 snmpV2-trap 1.3.6.1.2.1.1.3.8 1.3.6.1.6.3.1

<

» Internet Protocol Version 4, Src: 192.168.16.3, Dst: 192.168.18.188
> User Datagram Protocol, Src Port: 1297, Dst Port: 162
¥ Simple Network Management Protocol
version: v2c (1)
community: barox
v data: snmpV2-trap (7)
¥ snmpV2-trap
request-id: 1le4244592
error-status: noError (@)
error-index: @
v variable-bindings: 3 items
» 1.3.6.1.2.1.1.3.8: 37688141467
> 1.3.6.1.6.3.1.1.4.1.8: 1.3.6.1.4.1.43665.2.138.5.1.8.5 (1s50.3.6.1.4.1.43665.2.138.5.1.0.5)
¥ 1.3.6.1.4.1.43665.2.138,5.2.1: 5086f7274203320506T45205044206T6666
Object MName: 1.3.6.1.4.1.43665.2.138.5.2.1 (ise.3.6.1.4.1.43665.2.138.5.2.1)
Value (OctetString): 586T7274283328506T45205044206T6666

b4 bé 86 el 3b 78 38 b8 eb 21 5a 61 @3 @0 45 B0
@@ 9b @5 9a @0 @2 48 11 df @@ c@ a3 @a @3 c@ ad
@a 64 B85 11 @8 a2 @@ 87 ©6 ed 3@ 82 @@ 7b 82 @1
85 62 61 72 6f 78 a7 B2 @@ 6d B2 84 86 36
a5 7@ 82 91 @@ 82 @1 @@ 3@ 82 @@ 5d 38 82 e 11
@6 @3 2b 86 @1 @2 @1 @1 ©3 °@ 43 @5 @@ =@ 1d 43
1b 3@ 82 0@ 1d @6 8a 2b @6 @1 @6 @3 21 el 84 el
@e @6 of 2b @6 81 84 @1 282 d5 11 82 81 @a @5 el

@@ 23 86 @e 2b 86 61 84 @1 82 dS 11
a2 7 2
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* Lors de l'utilisation du logiciel, veuillez respecter les conditions de licence res pectives des
fournisseurs de logiciels.

Affichage des informations dans le navigateur SNMP :

A &

ce

Description Source Tirne Sewverity
.1,3.6.1.4.1,43665.2,.138.5.1.0.7 192,168.10.3 2018-11-12 15:14:30

.1.3.6.1.4.1.43665.2.138.5. 1.0.5 2018-11-12 15:14:30

.1,3.6.1.6.3.1.1.5.3 192,168.10.3 2018-11-12 15:14:30

..

Source: 192.168.103 Timestamp: 10444 hours 43 minutes 25 seconds SNMP Version: 2
Trap OID: 1.3.6.1.4.1.43665.2.138.5.1.0.5 Community: barox
Variable Bindings:

Name: is0.0rg.dod internet mamt mib-2_system.sysUpTime 0

Value: [TimeTicks] 10444 hours 43 minutes 25 seconds (3760100336)

Name: snmpTrapOID

Value: [OID] .1.3.6.1.4.1.43665.2.138.5.1.0.5

Name: 1.3.6.1.4.1.430665.2.138.5.2.1

Value: [OctetString] Port 3 PoE PD off
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La caméra PoE est reconnectée / appareil PD en ligne :

Apercu des informations envoyées par le switch :

(1 [snmp [X] -]
Mo. Time Source Destination Protocol  Length Info
366 9.674191 192.168.18.3 192.168.16.166 SNMP 168 snmpV2-trap 1.3.6.1.2.1.1.3.8 1.3.6.1.6.3.1.
489 13.784199 192.168.18.3 192.168.16.188 SNMP 280 snmpV2-trap 1.3.6.1.2.1.1.3.8 1.3.6.1.6.3.1.
€

community: barox
v data: snmpV2-trap (7)
¥ snmpV2-trap
request-id: 184244616
error-status: noError (@)
error-index: @
v variable-bindings: 3 items
¥ 1.3.8.1.2.1.1.3.8: 3708163910
Object Name: 1.3.6.1.2.1.1.3.6 (isc.3.6.1.2.1.1.3.8)
Value (Timeticks): 3768163918
v 1.3.6.1.6.3.1.1.4.1.@: 1.3.6.1.4.1.43665.2,138.5.1.8.5 (is0.3.6.1.4.1.43665.2.138.5.1.08.5)
Object Name: 1.3.6.1.6.3.1.1.4.1.8 (is0.3.6.1.6.3.1.1.4.1.8)
value (OID): 1.3.6.1.4.1.43665.2.138.5.1.8.5 (i50.3.6.1.4.1.43665.2.138.5.1.8.5)
¥ 1.3.6.1.4.1.43665.2.138.5.2.1: 586T7274203320506T452058442086T6e
Object Name: 1.3.6.1.4.1.43665.2.138.5.2.1 (is0.3.6.1.4.1.43665.2.138.5.2.1)
Value (OctetString): 5@6f7274283328506T45205044206T6e

ae60 b4 b6 86 el 3b 78 38 b8 eb 21 S5a 61 B8 88 45 @8
@ @@ 9a 12 63 @@ 2@ 48 11 d2 33 <@ ad Ba 83 c@ ad
@a 64 B9 c4 @@ 32 9@ 36 33 dB 30 B2 V@ Ta 62 el
@l 84 85 62 61 72 6f 78 a7 B2 @0 6c B2 @4 86 36
a5 88 82 @1 @@ B2 @1 @@ 38 B2 @@ 5c 3@ 32 88 11
85 88 2b 86 01 82 81 Bl @3 86 43 05 88 0 1T 5c
45 30 32 @@ 1d @6 8a 2b @6 81 @6 63 81 81 B4 a1
ea @s ©f 2b @6 @1 ©4 @1 82 d5 11 @2 81 @a 65 81
@@ 85 30 82 @@ 22 ©6 @ 2b 86 @1 @4 VL 32 d5 11
a5 28 33 2

Be98
aaad

Affichage des informations dans le navigateur SNMP :

En plus des OID (identifiants d'objets pour les unités d'information) correspondants des Traps,
une valeur pour la lecture ou l'interprétation du statut du message SNMP est généralement
ajoutée. Dans cet exemple, la derniére ligne est marquée & des fins illustration.

cCe

Description Source Time Severity
| | |
1.3.6.1.6.3.1.1.5.4 .168.10. 2018-11-12 15:25:08
2018-11-12 15:25:04

Source: 192.168.10.3 Timestamp: 10444 hours 33 minutes 59 seconds SNMP Version: 2
Trap OID: 13614143665.2.13851053 Community: barox
Variable Bindings:

Name: _iso.org.dod.internet mgmt mib-2 system svsUpTime.0

Value: [TimeTicks] 10444 hours 53 minutes 59 seconds (3760163910)

Name: snmpTrapOID

Value: [OID] .1.3.6.1.4.1.43665.2.138.5.1.0.5

Name: 1.3.6.1.4.1.43665.2.138.5.2.1

Value: [OctetString] Port 3 PoE PD on
|— —
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5.7 Utilisation de fichiers MIB pour la lecture et le contrdle des switches

Dans le réseau, le statut des périphériques gérables tels que les switches, les routeurs ou les
serveurs peut généralement étre interrogé via la fonctionnalité SNMP. Pour des raisons de
sécurité ou spécifiques au fabricant, ces fichiers MIB sont souvent nécessaires pour interroger
les appareils. Ces fichiers contiennent les informations relatives aux indicatifs d'identification
des fonctions.

Interrogation des fonctions d'état du switch via SNMP a l'aide de fichiers MIB

L'utilisation d'un navigateur MIB est recommandée pour l'introduction. Dans I'exemple, on utilise
le **"MIB Browser d'iReasonning” (http://www.ireasoning.com/mibbrowser.shtml) pour sa vue
ergonomique. Le navigateur doit également étre configuré avec les paramétres SNMP
appropriés pour se connecter au switch correspondant.

Etape 1 Import du fichier MIB

Lors de I'import, assurez-vous que le fichier MIB approprié est sélectionné pour le switch
correspondant. Les fichiers MIB requis sont reconnaissables au préfixe ".mib".

¥ iReasoning MIB Browser
File | Edit Operations Tools Bookmarks Help
=7 \Load MIBs Ctrl+L Advanced... OID: |. 1.
UnlLoad MIBs

MIB Modules

Open Sessicn

Save Session

Exit

* Lors de l'utilisation du logiciel, veuillez respecter les conditions de licence respectives des
fournisseurs de logiciels !

Une fois I'import réussi, les structures MIB sont affichées comme suit.

>

File Edit Operations Tools Bookmarks Help

Address: [E2] b4
SNMP MIBs = o
S Suchenin: [ | 2018 ] - @& e @ |
- | iso.org.dod.internet Name Anderungsdatum Typ ™
* | RY-LG523-10G.mib 08.01.2018 11:30 MIB-D
Schnellzugriff [ gy 6523-26.mib 08.01.2018 11:30 MIB-D
[ RY-LGS025-24.mib 08.01.2018 11:29 MIB-D
| | RY-LG5025-28.mib 08.01.2012 11:29 MIB-D
Desktop | RY-LGSP16-10.mib 08.01.2012 11:30 MIB-D
| RY-LG5P23-10G.mib 08.01.2018 11:30 MIB-D
| RY-LGSP23-26.mib 08.01.2012 11:31 MIB-D
Bibliotheken | | RY-LGSP23-26-370.mib 08.01.2012 11:31 MIB-D
_ | RY-LGSP23-28.mib 08.01.2012 11:32 MIB-D
& | RY-LG5P23-28-370.mib 08.01.2018 11:32 MIB-D
Dieser PC || RY-LGSP23-52mib 08.01.2018 11:32 MIB-D
| RY-LGSP23-52-740.mib 08.01.2018 11:32 MIB-D
@# B 1 RV-1 RGSDTRI2.7A mih Nant 2012 11.44 ’Mln.;\ 2
Metzwerk
Dateiname: [RY-LGSP23-10G «|  [Cofimen_|
Dateityp: Al Files (* %) ~ Abbrechen
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e iReasoning MIB Browser

File Edit Operations Tools Bookmarks Help
Address: | 192, 168.10.3 o Advanced... omb: |.1.3.6.1.4.1,
SMMP MIBs
MIE Tree
= | iso.org.dod.internet
-- mgrmt
B- | private
B- | enterprises
= | privatetech
= | switch
E} | rylgsp2310gProductld
N N 0=p 231005 ystem
rylasp2310gConfiguration
rylasp2310g5ecurity
rylasp2310gMaintenance
rylasp2310gTrap
Etape 2 Générer des requétes

Pour générer une requéte, sélectionner d'abord I'état désiré, effectuer I'opération "Get Next"
et cliquer sur "Go" pour générer la requéte. Aprés une requéte réussie, les informations sur
le statut apparaissent dans le tableau des résultats comme indiqué dans I'exemple ci-dessous.

& iReasoning MIB Browser

File Edit Operations Tools Bookmarks Help

— O

X

~ Operah'ons:l Get Next w ' Go

Address: |192.168.10.2 e Advanced... QID: .1.3.6.1.4.1.47647.1595.15.2.1. 1.1.4.1
SNMP MIBs Result Table Trap Receiver
A
internet hizane AT
rylgsp2310gPortCo... |1G Ful
rprises
privatetech
switch
B rylgsp2310gProductld
rylgsp2310gSystem
S rylgsp2310gConfiguration
S | rylgsp2310gPort
B- [ rylasp2310gPortConfigurationTable
B- Eg‘ rylgsp2310gPortConfigurationEntry
% rylgsp2310gPortConfPart
----- ‘ rylgsp2310gPortConfPortMedia
----- &) rylasp2310gPortConflink
----- rylgsp2310gPortConfCurrentSpeed
-4 rylosp2310gPortConfSpeed
----- &) rylosp2310gPortConfCurrentFlowC
5 rylgsp2310gPortConfCurrentFlowCe
--|#f rylgsp2310gPortConfFlowControl
@ rylgsp2310gPortConfMaxFrameSize
..[B® rulnen)HNABAr anFEvrecivaralic ¥
< >
MName rylgsp2310gPortConfCurrentSpeed
Lo n] .1.3.6.1.4.1.47647.1595. 15.2. 1.1. 1.4
MIE PRIVATETECH-RYLGSP2310G-FUNCTION-MIB
Syntax DISPLAYSTRING (5IZE (6..12))
ArCcess read-only
Status current
Defval
Indexes rylgsp2310gPortConfPort
The current link speed of the port.
Descr

barox
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5.8 Commande des fonctions du switch via SNMP et MIB en utilisant I'opération "SET"

Comme autre méthode de commande des switches barox, il est possible d'effectuer I'opération
"SET" via le protocole SNMP. Les configurations SNMP de base sur le switch et le navigateur
MIB sont prérequises. Voici un exemple d'utilisation de I'opération SET qui déclenche l'arrét
du port et la reconnexion au switch.

Pour désactiver le port 2 au niveau du switch, on recherche la configuration des ports dans le
répertoire MIB. Veuillez pour cela vous assurer d'avoir sélectionné le bon bloc d'informations
avec la fonction d'écriture. L'opération Set s'ouvre en cliquant sur "Go" et I'entrée OID doit se
terminer par ".2" (identification du port 2). En outre, on entre la valeur "0" (pour désactiver) et
on confirme par "OK". Aprés une opération réussie, un message de confirmation est généré en
conséquence.

v
File Edit Operations Tools Bookmarks Help
Address: |192.168,10.2 ~ Advanced... OID: |.1.3.6.1.4.1,47647.1595.15.2. 1.1. 1.5 ~ | Operations: | Set ~ & Go
SNMP MIBs Result Table l Trap Receiver l
Bl | rylgsp2310gConfiguration A
. M, D Val T IP:Port
=+ | rylgsp2310gPort SEE | e L or o

= [ rylosp2310gPortConfigurationTable

- @ rylgsp2310gPortConfigurationEntry
% rylgsp2310gPortConfPort & SMMP SET ™
‘ rylgsp2310gPortCanfPortMedia

‘ ryigzp2310gPortCenflink QD |.1.3.6.1.4.1.47547.1595.15.2.1. 1. 1.5 C
- rylgsp2310gPortConfCurrentSpee. | | T DT : 134 1.L1.9 ,)
=3

Data Type [Integer — v
‘ rylgsp2310gPortCanfCurrentFlow:
-1 rylgsp2310gPortConfCurrentFlow: Value D-
E rylgsp2310gPortCanfFlowControl
@ rylgsp2310gPortCanfMaxFramesiz
@ rylgsp2310gPortCanfExcessiveCo
[ rylgsp2310gPortConfPowerContre Cancel
@ rylgsp2310gPortConfDescription
o [ rylosp2310gPortTrafficStatisticsTable
b rylgsp2310gPortQoSStatistics
- [ rylosp231005FPInfoTable

[#- | rylgsp2310gVoiceVLAN
[+ rylgsp2310gGVRP
[#- | rylgsp2310gMirroring
G| rulnen 2 NATranFuantSayverit e
< >
Name rylgsp2310gPortConfSpeed
QID .1,3.6.1.4.1.47547.1595,15.2.1.1.1.5
MIB PRIVATETECH-RYLGSP2310G-FUNCTION-MIB
Syntax INTEGER32 (0..11)
Access read-write
Status current
DefVal
Indexes rylgsp2310gPortConfPort
default: 1,
0:disable state,
1rauto,
2:10 Half,
3:10 Full,
4:100 Half,
Descr 5:100 Full,
6:1G full,

SET succeeded
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Pour activer le port 2 au niveau du switch, on recherche la configuration des ports dans le

répertoire MIB. Veuillez pour cela vous assurer d'avoir sélectionné le bon bloc d'informations

avec la fonction d'écriture. L'opération Set s'ouvre en cliquant sur "Go" et I'entrée OID doit se

terminer par ".2" (identification du port 2). En outre, on entre la valeur "1" (pour activer) et on

confirme par "OK". Aprés une opération réussie, un message de confirmation est généré en

conséquence.

LY

File Edit Operations Tools Bookmarks Help
‘ddress: | 192,168.10.2 ~ Advanced...

SNMP MIEs

= | rylgsp2310gConfiguration

=+ | rylgsp2310gPort

= [ rylgsp2310gPortConfigurationTable

=8 [’g‘ rylgsp2310gPortConfigurationEntry
% rylgsp2310gPortConfPort

----- ‘ rylgsp2310gPortConfPortMedia
-1 rylgsp2310gPortConflink

rylgsp2310gPortConfSpeed

rylgsp2310gPortConfFlowControl

- [2¥ rylgsp2310gPortConfExcessiveCo

@ rylasp2310gPortConfDescription

barox Kommunikation

Result Table l Trap Receiver

OID: |.1.3.6.1.4.1.47547.1595.15.2.1.1.1.5

~ | Operations: | Set

& Go

Mame0ID

Value Type

IP:Port

& SNMP SET

X

rylgsp2310gPortConfCurrentSpee

‘ rylgsp2310gPortConfCurrentFlow
5 rylgsp2310gPortConfCurrentFlow

@ rylgsp2310gPortConfMaxFramesi;

OID |.1.3.6.1.4.1.47647.1595.15.2, 1. 1.1.5{

Data Type | Integer

Value |1

rylgsp2310gPortConfPowerContre

Cancel
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6 Mise a niveau du firmware

En raison des mises a jour régulieres du logiciel pour le dépannage et l'introduction de nouvelles
fonctionnalités, il est recommandé de mettre a jour le firmware de temps en temps.

7 9 11 13 15 17 19 21 23 25

Y barox:= : G S e Moo

46 & 10 12 14 16 18 20 22 24

RY-LGSP23-28/370

Software Upload @tHome Firmware Upgrade
Switch DMS
Firmware File Durchsuchen... | Keine Datei ausgewéhit.
£+ Configuration <
0 Monitor <
Upload
& Diagnostics <
/& Maintenance v

> Restart Device

> Reboot Schedule

> Factory Defaults

» Firmware "
> Firmware Upgrade
> Firmware Selection

Le nouveau firmware est disponible immédiatement apres l'upgrade. Si, pour une raison
guelconque, I'ancien firmware devait étre a nouveau installé, vous pouvez le réactiver tres
simplement dans le menu "Firmware Selection".

> barox = e
B Software Image Selection @rome Firmuare Selection
Switch DMS
Active Image
& Configuration <
Image managed
O Monitor <
Version RY-LGSP23-28/370 (standalone) v6.54.3133
&siblagnostcs < Date 2019-04-04T00:51:35+08:00
/& Maintenance v

Alternate Image
> Restart Device

> Reboot Schedule Image managed.bk
> Factory Defaulls Version RY.LGSP23-28/370 (standalone) v6.54.2997
SEumms " Dpate 2018-11-01T00:07:09+08:00

> Firmware Upgrade

> Firmware Selection Activate Alternate Image |

» Configuration <

> Server Report
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7 Réglages d'usine

Les switches peuvent étre réinitialisés a tout moment aux réglages d'usine.

Soit par logiciel via le menu "Maintenance/Factory Defaults", soit en appuyant sur la touche
de réinitialisation sur la face avant (plus de 10 secondes).

En cochant la case "Keep IP setup”, le switch conserve I'adresse IP configurée tandis que tout
le reste est réinitialisé aux réglages d'usine.

H e

> barox=

m

Factory Defaults @Home - Maintenance - Factory Defaults

Are you sure you want to reset the configuration to Factory Defaults?

04 Keep IP setup

Yes
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8 Server Report

Lors de demandes d'assistance, le Server Report doit également étre envoyé. Il contient une
présentation de I'ensemble de la configuration et d'autres informations utiles pour le technicien
d'assistance.

( barox

RY-LGSP16-10

H

Server Report @Home - Maintenance - Server Report

,,.,]‘ H 0 c

Switch DMS .
Please note: server-report may take a while to prepare for download.

O Monitor <
&% Diagnostics <
/& Maintenance v
> Restart Device
> Reboot Schedule
> Factory Defaults
» Firmware <
» Configuration <

> ServerReport

Extrait d'un Server Report

i] server-report - Editor

Datei Bearbeiten Format Ansicht 7

Model MName: RY-LGSP16-10

Connected Devices: 1
PoE Power Consumption: © [W]
Total PoE Available: 130 [W]

Firmware Version: v6.54.2729 2017-12-22
MAC Address: 38-b8-eb-20-34-62
System Uptime: 02:57:16

IP Address: 192.168.1.1
Subnet Mask: 255.255.255.0
Gateway: 192.168.1.254
Primary DNS: 8.8.8.8

hostname RY-LGSP16-1@username admin privilege 15 password encrypted YWRtalid=!vlan 1!!!ip route 0.0.0.0 0.0.0.
t-to-point!!line console @!line vty @!line vty 1!line vty 2!line vty 3!line vty 4!line vty 5!line vty 6!line
----- System log -----

2011-01-01T01:00:03+01:00 RY-LGSP16-10
2011-01-01701:00:03+01:00 RY-LGSP16-10
2011-01-01T701:00:05+01:00 RY-LGSP16-10
2011-01-01701:00:09+01:00 RY-LGSP16-1@ [ Info topologyChange
2011-01-01701:00:11+01:00 RY-LGSP16-10 [ Info topologyChange

[ Warning ] Switch just made a cold boot
[
[
[ 1
[ ]
2011-01-81701:00:52+01:00 RY-LGSP16-10 [ Info ] Topology: MNew Device(192.168.1.111) add
[ ]
[ ]
[
[
[

Info ] Password of user 'admin' was changed
Warning ] Link up on port 6

2011-01-01701:01:03+01:00 RY-LGSP16-10 [ Info Topology: Device(TECHNIK-ASUS 192.168.1.111) Off-line is «¢
2011-01-01701:01:04+01:00 RY-LGSP16-1@ [ Warning ] Link down on port 6

2011-01-01701:01:04+01:00 RY-LGSP16-10
2011-01-01701:01:06+01:00 RY-LGSP16-10
2011-01-01701:01:06+01:00 RY-LGSP16-10

Info ] topologyChange
Warning ] Link up on port 6
]

Info topologyChange
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9 GARANTIE

barox Kommunikation garantit que le produit est exempt de défauts de matériaux et
de fabrication pendant toute la durée de la période de garantie spécifique au pays.

La garantie de barox Kommunikation est indépendante de I'obligation de garantie du
vendeur découlant du contrat d'achat avec le client final et ne |'affecte d'aucune facon.

barox Kommunikation réparera gratuitement les défauts du produit qui sont dus a un
défaut de matériau et/ou de fabrication et qui sont signalés a barox Kommunikation
pendant la période de garantie. barox Kommunikation décidera, a sa seule discrétion,
de la mesure a prendre pour réparer le défaut. La garantie pour les piéces réparées ou
remplacées est donnée pour le reste de la période de garantie.

Le programme de garantie ne s'applique pas aux produits dont le numéro de série a été
retiré, masqué ou modifié. La garantie ne couvre pas non plus les dommages suivants :

1. Dommages dus a un accident ou a une utilisation incorrecte ou incorrecte,
en particulier le non-respect des instructions d'utilisation du produit.

2. Dommages causés par l'utilisation de piéces non fabriquées ou distribuées
par barox Kommunikation.

3. Dommages causés par des modifications effectuées sans l'accord écrit
préalable de barox Kommunikation.

4, Dommages résultant de services non fournis par barox Kommunikation
ou par des représentants autorisés de barox Kommunikation.

5. Dommages causés par le transport, la négligence, les fluctuations ou les

pannes de l'alimentation électrique, la force majeure ou I'environnement
d'exploitation.

6. Dommages dus a l'usure normale

7. Dommages causés par des virus informatiques et autres logiciels

8. Dommages causés par la configuration ou la reconfiguration des mots de
passe

Pour les prestations fournies par barox Kommunikation dans le cadre de la réparation de
tels défauts ou dommages imputables a I'un des motifs d'exclusion énumérés ci-dessus,
des frais supplémentaires seront facturés pour I'exécution du travail, le transport et les
piéces. Des frais supplémentaires seront facturés pour la réinstallation du logiciel
d'origine.
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